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1.1. RESUMEN

La Realidad Virtual es una simulacién realista y envolvente de un entorno tridimensional
creada por ordenador. Esta tecnologia simula la presencia fisica del usuario en dicho
entorno, permitiéndole interactuar con él a través de unas gafas o casco de Realidad
Virtual.

La Realidad Virtual ha generado mucho entusiasmo en el campo de los videojuegos,
pero sus aplicaciones pueden alcanzar numerosas disciplinas. Cualquier profesion que
utilice modelado 3D puede beneficiarse de esta tecnologia ya que la sensaciéon de
inmersién que genera puede ser muy Util.

Actualmente en el campo de la ingenieria civil se esta implementando la gestion de
proyectos a través del BIM (Building Information Modeling) que se basa en realizar
proyectos mediante un modelo tridimensional digital que abarca la geometria, las
relaciones espaciales, la informacion geogréfica, asi como las cantidades y las
propiedades de sus componentes.

Lo mas destacado de estos modelos es su tridimensionalidad y, por tanto, es logico que
la forma de interactuar con ellos sea a través de interfaces 3D, es decir, la Realidad
Virtual ofrece cambiar el interfaz con el que acercarse a los modelos BIM para
aprovechar todo su potencial. Por ello, la Realidad Virtual se presenta como una
tecnologia con un gran futuro para el intercambio de informacion entre los diferentes
integrantes de un proyecto y una herramienta de ayuda al disefio.

En este estado de desarrollo se enmarca el presente proyecto, con objeto de explorar
las posibles aplicaciones de la Realidad Virtual en la ingenieria civil llevando a cabo un
ejemplo practico de virtualizacién de una obra.

En la bisqueda de la herramienta que permitiese interactuar con modelos
tridimensionales a través de un dispositivo de Realidad Virtual, se ha escogido Unity 3D
como plataforma de desarrollo del proyecto, ya que simplifica la tarea de trasladar
modelos CAD, BIM o cualquier modelo tridimensional, a un entorno virtual. Y no sélo
eso, sino que ademas Unity 3D permite generar una aplicacibn para numerosas
plataformas objetivo entre las que se encuentran las gafas o cascos de Realidad Virtual
mas populares (Oculus Rift, HTC Vive, PlayStation VR, Samsung Gear VR).

Por altimo, el presente proyecto profundiza en el proceso de virtualizaciéon de una obra
para que todo profesional del sector, principiante en esta nueva tecnologia, disponga de
los recursos necesarios para crear una aplicacion orientada al uso de dispositivos de
Realidad Virtual. Entre las caracteristicas del modelo destaca la posibilidad de importar
el terreno real a partir de datos de Instituto Geografico Nacional, asi como la posibilidad
de interactuar con los objetos que forman parte de él.

Para la interaccion con el entorno, Unity permite programar el comportamiento de los
objetos que forman parte del mismo. En el presente proyecto se han creado scripts, en
el lenguaje de programacion C#, mediante los cuales se afiaden instrucciones que
definen el comportamiento de los objetos. Tras estudiar diversas opciones se ha optado
por desarrollar dos formas intuitivas de interactuar con los objetos en entonos adaptados
a la Realidad Virtual, a saber, acercandonos a ellos o mirandolos.

Finalmente, se ha creado una aplicacion para PC que soporta el uso de dispositivos de
Realidad Virtual, en la que se muestra la obra modelizada a través de un personaje en
primera persona que puede moverse alrededor del entorno virtual e interactuar con los
diferentes objetos que lo conforman.
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1.2. ABSTRACT

Virtual Reality is a realistic and immersive simulation of a three-dimensional environment
computer-generated. This technology simulates the user physical presence and it also
allows to interact with the environment helped with a HMD (Head Mounted Display).

Virtual Reality has generated a huge excitement in the field of video games, but it could
be used in many different disciplines. Any profession that uses 3D modelling can be
benefited from this technology thanks to the feeling of immersion that Virtual Reality
allows.

Nowadays, in the field of civil engineering it has been implemented the BIM (Building
Information Modelling) which is a project management methodology through a digital
three-dimensional model that covers geometry, spatial relationships, geographic
information, and the quantities and properties of its components.

The highlight of these models is their three-dimensionality and, therefore, it is logical that
the way to interact with them should be through 3D interfaces. That is to say, the Virtual
Reality offers an interface change to approach the BIM models which permits to exploit
its full potential. Therefore, the Virtual Reality presents itself as a technology with great
potential for the exchange of information between the different members of a project and
as design support tool.

It should be noted that, as a developing technology, there are limitations in its application
and the availability of equipment is still insufficient in order to make the Virtual Reality
technology affordable to all professionals. In this stage of development, the aim of this
project is to explore the possible applications of Virtual Reality in the civil engineering
field undertaking a practical example of making a virtualization of a real work.

Searching for a tool which allows to interact with three-dimensional models through a
Virtual Reality device is has been chosen Unity 3D development platform because it
extraordinarily simplifies the task of import CAD, BIM maodels or any three-dimensional
model to a virtual environment. Not only that, but it also has numerous target platforms
among the most popular HMD (Oculus Rift, HTC Vive, PlayStation VR, Samsung Gear
VR).

Finally, this project explores the virtualization of a work pursuing the goal of creating a
guide for all the professionals who wants to learn about Virtual Reality and the
possibilities that it offers. Among the features of the model highlights the possibility to
import a real terrain data from the National Geographic Institute and the ability to interact
with the objects that are part of the model.

In order to create a way of interaction with the environment, Unity allows to program the
behaviour of the objects that are part of it. Scripts has been created, in the programming
language C #, using them to add instructions that will define the behaviour of objects.
After studying various options, it has been chosen to develop two intuitive ways to
interact with objects in Virtual Reality environments, by approaching them or by looking
at them.

Finally, it has been created a PC application that supports the use of Virtual Reality

devices in which the work is displayed through a character in first person who can move
around the virtual environment and interact with different objects.
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2.1. CONTEXTO

La Realidad Virtual se basa en la creacién de un entorno tridimensional modelado
digitalmente. Por otra parte, existe la Realidad Aumentada, cuya caracteristica principal
€S que a un entorno u objeto real se le afiade informacion digital, es decir, la Realidad
Aumentada crea una “realidad mixta” entre elementos creados digitalmente y elementos
reales.

El nacimiento de la Realidad Virtual ha sido posible gracias a dos grandes avances
producidos en el mundo de los teléfonos moviles: el desarrollo de pantallas ligeras,
baratas y de alta resolucion, asi como el de una nueva generacion de sensores de
movimiento de gran precision.

Estos avances han logrado que sea posible la creacién de las gafas o cascos de
Realidad Virtual gue han permitido pasar de mostrar los gréficos a través de la pantalla
del ordenador a reproducirlos en unas gafas que crean la ilusion de que lo que estas
viendo a través de ellas es real. Estos dispositivos permiten observar desde todas las
perspectivas simplemente moviendo la cabeza. Para desplazarse por la escena puede
usarse mandos o sensores de movimiento, todo ello logra que la persona se sumerja
completamente en el entorno virtual.

La Realidad Virtual ha generado mucho entusiasmo en el campo de los videojuegos,
pero sus aplicaciones pueden alcanzar numerosas disciplinas. Cualquier profesion que
utilice modelado 3D puede beneficiarse del uso de la Realidad Virtual ya que la
sensacion de inmersion puede ser muy Util para campos tan diversos como la
educacion, la ingenieria, el marketing, el entretenimiento o el desarrollo de negocios.

Dentro de la ingenieria existen varios ejemplos donde esta tecnologia puede ser
aplicada como:

— Laingenieria mecanica y disefo industrial: En el disefio asistido por ordenador
como AutoCAD o SOLIDWORKS, con la Realidad Virtual, ingenieros y
disefiadores pueden experimentar la sensacion de tener en sus manos el
producto antes de producirlo y simular diferentes escenarios a un precio
reducido.

— La ingenieria civil y arquitectura: Los arquitectos e ingenieros siempre han
construido modelos a escala de sus disefios, tanto para mostrar y vender sus
disefios a los clientes como para validar las hipétesis asumidas durante la fase
de disefio. Hoy en dia, el software de modelado y renderizado es ampliamente
utilizado para construir modelos virtuales. La Realidad Virtual facilita la
negociacién con los clientes o inversores, permitiendo experimentar un disefio
antes de construirlo.

— La simulacion de actividades: otra posible aplicacion dentro del mundo de la
ingenieria es la simulacién de procesos complejos, como un simulador de vuelo
para pilotos. La Realidad Virtual permite simular el proceso de vuelo y con ello
el personal responsable de la operacion puede entrenarse para realizar su tarea
de forma barata, simple y segura. Otro ejemplo de aplicacion dentro de la
ingenieria puede ser la simulacion del proceso de mantenimiento de una central
nuclear donde el personal tiene una sola oportunidad para desarrollar su
actividad y el tiempo de realizacion de dicha actividad es crucial.
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2.2. COMO FUNCIONAN LOS DISPOSITIVOS DE REALIDAD
VIRTUAL

Un casco de Realidad Virtual, también llamado gafas de Realidad Virtual o HMD (del
inglés Head-Mounted Display), es un dispositivo de visualizacién que permite reproducir
imagenes creadas por ordenador sobre una pantalla muy cercana a los o0jos.

Debido a su proximidad con los ojos el casco de Realidad Virtual consigue que las
imagenes visualizadas resulten mucho mayores que las percibidas por pantallas
normales, y permiten incluso englobar todo el campo de visién del usuario. Gracias a
que el casco se encuentra sujeto a la cabeza, éste puede seguir los movimientos del
usuario, consiguiendo asi que se sienta integrado en los ambientes creados por
ordenador.

En ocasiones las gafas estdn acompafiadas de guantes con sensores, mandos con
control de movimiento o camaras de posicionamiento que permiten hacer cosas como
andar dentro del escenario o tocar los objetos virtuales.

Hoy en dia, las gafas de Realidad Virtual no incorporan el procesador, es decir, para
disfrutar de la Realidad Virtual se necesitan dos dispositivos: las gafas y el dispositivo
gque genera el entorno virtual como puede ser un ordenador o una videoconsola. Para
el presente proyecto se ha contado con el set de Oculus Rift que cuentan con un casco
con dos lentes y unos auriculares, un mando inaldmbrico y un rastreador de posicion.

El funcionamiento es sencillo, las gafas estan formadas por una pantalla y unas
lentes. Las lentes amplian el angulo de vision, generando la sensacién de que la pantalla
abarca todo el espectro visual del usuario. Por otro lado, el dispositivo informatico
genera dos imagenes diferentes, una para cada ojo, produciendo un efecto 3D. Esto es
posible gracias a la vision estereoscopica, es decir, la percepcion de dos imagenes
ligeramente diferentes, una en cada 0jo, como una sola imagen. Dando lugar a la
percepcién de profundidad, que permite ver el mundo en tres dimensiones.

Para recrear esto, es necesario generar dos puntos de vista ligeramente diferentes, uno
recibido por los ojos izquierdo y otro por el derecho cuando el usuario esta utilizando el
HMD.

S~
OO S

Figura 1. Como recrear imagenes estereoscopicas en 3D*

1 (steveluscher, 2005-2016)
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2.3. LA INGENIERIA CIVIL Y LA REALIDAD VIRTUAL

Los modelos relacionados con la construccién necesitan ser capaces de generar
cambios en la geometria del proyecto. La integracién de dicha geometria junto con el
plan del proceso constructivo son la base de los modelos en 4D (3D + tiempo) que junto
a la Realidad Virtual permiten una representacion muy realista de la obra y su
construccion.

Los modelos en 4D tiene numerosas aplicaciones como la mejora de la productividad,
el andlisis, el disefio y la coordinacion del proyecto. En este contexto la Realidad Virtual
permitiria a los usuarios observar cada fase del proyecto para analizarla y manipularla
tridimensionalmente de forma interactiva y en tiempo real. Por ello, se presenta como
una tecnologia con un gran potencial para el intercambio de informacién entre los
diferentes integrantes de un proyecto y una herramienta de ayuda al disefio.

El BIM (Building Information Modeling) es una metodologia de trabajo para la gestion de
proyectos de edificacién u obra civil a través de una maqueta digital. Esta maqueta
digital conforma el modelo de informacién del proyecto que abarca la geometria, las
relaciones espaciales, la informacion geogréfica, asi como las cantidades y las
propiedades de sus componentes.

Actualmente, las empresas y profesionales esparfioles que quieran participar en
proyectos de construccién, reforma, instalacién, y explotaciéon en lugares como Reino
Unido, EE.UU., Emiratos Arabes, China o Australia tienen que implantar el modelo BIM
de manera obligatoria para acceder a licitaciones, contratos y colaboraciones. Y no sélo
eso, sino que el Ministerio de Fomento ha marcado para el afio 2018 como fecha limite
para implantar, en las fases de disefio y construccion, el uso de un modelo BIM para las
licitaciones de equipamientos e infraestructuras publicas de presupuesto superior a 2
millones de euros.

Por lo que se puede afirmar con seguridad que en un futuro préximo toda obra de
envergadura tendra su modelo BIM. Lo que abre las puertas a un mercado creciente en
todo lo relacionado con el modelado tridimensional.

Existen varias finalidades para la creacién de un modelo BIM que pueden diferir tanto
en su enfoque, como en su alcance, complejidad, nivel de detalle y profundidad de la
informacion incorporada al modelo 3D. Entre dichas finalidades se encuentra la
visualizacién de la obra que se va a construir, que ofrece una ayuda para la toma de
decision en el proceso de disefio mediante la comparacién de diferentes alternativas,
asi como la posibilidad de vender el disefio al cliente o a los ciudadanos, que podria
tener un voto sobre el proyecto. 2 A su vez ofrece la integracion de diferentes elementos
como la estructura, las instalaciones, etc. en un mismo modelo y proporciona
informacion sobre la planificacién temporal de los trabajos, o su coste. Por otro lado,
ofrece la posibilidad de mostrar visiones parciales del modelo para la formacién de los
equipos que van a participar en los trabajos constructivos.

Asi, lo mas destacado de estos modelos es su tridimensionalidad y, por tanto, es logico
que la forma de interactuar con ellos sea a través interfaces 3D. Es decir, la Realidad
Virtual ofrece cambiar el interfaz con el que acercarse a los modelos BIM para
aprovechar toda su potencialidad.

2 (GRAPHISOFT, 2016)
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3. UNITY 3D
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3.1. INTRODUCCION

Trasladar modelos CAD o BIM a un entorno virtual que permitiese el uso de la Realidad
Virtual solia precisar de una gran cantidad de tiempo y de amplios conocimientos de
programacion. La plataforma para la creacion de aplicaciones Unity 3D, principalmente
enfocado al desarrollo de videojuegos, permite importar modelos BIM a entornos
virtuales simplificando mucho el proceso necesario para virtualizar una obra e
interactuar con ella en 3D. Ademas, Unity 3D, permite desarrollar contenidos interactivos
en tres dimensiones de manera gratuita y accesible y por ello se ha escogido como
plataforma para desarrollar el proyecto.

Existen diferentes modelos de licencia de Unity, la plataforma ofrece una version de
pago (Unity Pro) asi como una version gratuita (Unity Personal). La version gratuita
permite desarrollar y publicar proyectos, con algunas restricciones o funciones no
disponibles. En el contexto de investigacion y desarrollo para la Ingenieria Civil del
presente proyecto la version gratuita Unity Personal satisface todas las necesidades®.

A continuacion, se indican algunas de las caracteristicas mas destacadas del motor:

- Gran diversidad de plataformas objetivo: Windows, iOS, Android, WebGL,
Oculus Rift, HTC Vive, PlayStation VR, Samsung Gear VR, ect.

- Soporte de texturas 3D y mapeado de relieve.

- Tienda con paquetes gratuitos en una amplia gama de categorias, incluyendo
modelos 3D, texturas y materiales, sistemas de particulas, musica, efectos de
sonido, tutoriales, proyectos y paquetes de scripts entre otros.

- El programa ofrece integracion nativa con Visual Studio. Unity admite como
leguajes de programacion el C# y el JavaScript. Ademas, ofrece todas las
prestaciones con path finding y mallas de navegacion avanzadas vy
automatizadas.

3.2. INTRODUCCION AL MANEJO DE UNITY 3D

El presente aparatado tiene como objetivo introducir Unity 3D para poder explicar el
alcance de la plataforma. A mismo tiempo ha de servir como base para el ejemplo de
virtualizacién de la obra objeto de este proyecto.

3.2.1. El editor

Cuando se ejecuta el programa, creando un proyecto nuevo, la interfaz aparece dividida
en diferentes ventanas, principalmente son:

- Scene (escena): en esta ventana es donde se gestiona el proyecto. Permite
manipular los elementos para realizar ciertas acciones sobre ellos como puede
ser: mover, redimensionar o rotar entre otros.

- Game: muestra el resultado de la ejecucion de la escena actual. Para ejecutar
nuestro proyecto es necesario pulsar el botén de reproducir situado en la parte
superior de la pantalla.

3 (Unity Technologies - Unity Store, 2016)
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- Console: en esta ventana se muestran los mensajes que proporciona el editor,
avisa de problemas que puedan estar ocurriendo durante la creacion del
proyecto.

- Hierarchy (&rbol): en esta ventana se muestran todos los objetos presentes en
la escena. Cuando se selecciona un objeto en el arbol éste aparece marcado en
la escena lo que nos permite interactuar con él. Del mismo modo sus
componentes apareceran en la ventana Inspector.

- Inspector: es la ventana méas importante del editor. En ella se muestran los
detalles de todos los componentes del objeto que se tenga seleccionado.

- Project: en esta ventana se los recursos que han sido incluidos en nuestro
proyecto, organizados en carpetas.

ESCENA

Figura 2. Interfaz Unity 3D

La interfaz del editor de Unity es personalizable y pueden afiadirse cuantas ventanas se
necesiten simplemente acudiendo a la pestafia en Menu > Window. Asi mismo la
disposicion de las ventanas puede adaptarse a los gustos del usuario.

3.2.1.1. Assets o recursos

El proyecto contiene una serie de assets o recursos, principalmente son:

- Escenas: Es el recurso principal, como su nombre indica en cada una de ellas
se guarda la escena, es decir, la representacion de un modelo, o fase del mismo.

- Materiales: Definen el aspecto que se le puede dar a una malla (textura, color,
sombreado, etc.).

- Scripts: Permiten personalizar el comportamiento de los objetos mediante
programacion.
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- Clips de audio: Musica y efectos de sonido.

La carpeta principal del proyecto se llamada Assets y se crea automaticamente al
originar un proyecto nuevo. Esa carpeta contendrd tanto las escenas de nuestro
proyecto como los recursos que forman parte de él.

En el interfaz del programa se pueden ver los recursos del proyecto en una pestana
llamada “Assets” dentro de la ventana “Project”, en la figura 2 ésta pestafia se localiza
en la parte inferior de la pantalla. Es muy importante mantener el sistema de carpetas
organizado ya que a medida que se crea el proyecto y se importan recursos puede ser
dificil encontrar los elementos que queramos utilizar. Para crear una carpeta basta con
situarse en la ventana Assets, hacer clic en el botén derecho y escoger la opcién
Create< Folder.

3.2.1.2. Arbol
En Unity 3D cada modelo se almacena en un asset de tipo escena. Cada escena tiene
un arbol donde aparecen todos los objetos que forman la escena. Cuando se selecciona
un objeto en el arbol éste aparece marcado en la escena lo que permite interactuar con
él. Del mismo modo, sus componentes apareceran en la pestafia Inspector.
En el interfaz del programa podemaos ver el arbol dentro de la pestafia “Hierarchy”, en la
figura 2 de ésta pestafia se localiza en el lado izquierdo de la pantalla.

3.2.1.3. Inspector

Asi mismo, si seleccionamos un objeto del arbol podemos observar sus componentes
en la pestafa “Inspector”.

Estas componentes son las caracteristicas del objeto que engloban un sinfin de
propiedades que podemos afiadir al objeto entre los que destacan:

- Caracteristicas geométricas: posicion, rotacion y escala.

- Mallado que conforma y delimita el objeto tridimensionalmente, incluyendo el tipo
de material o la textura.

- Caracteristicas fisicas: el tipo de interaccion con otros objetos.
- Scripts para controlar el funcionamiento del objeto.
3.2.2. Objetos
Unity 3D permite crear distintos tipos de objetos (Game Objects) predefinidos en el menu
GameObject. Estos objetos predefinidos llevan de forma predeterminada una serie de
componentes, entre ellos destacan:
- Objetos 3D: Estos objetos permiten crear nodos con formas geométricas
bésicas, es decir, planos, cubos, esferas, cilindros, etc. Incorporan una serie de
componentes basicas: posicion, orientacién, material, malla geométrica y

geometria de colision. En caso de que se quiera afiadir al entorno objetos con
caracteristicas geométricas mas complejas lo recomendable es acudir a un
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programa de modelado tridimensional como puede ser Sketch Up o Blender para
posteriormente importar el objeto a Unity.

- Empty Game Object: es un objeto vacio que sélo tiene las componentes de
posicién y orientacion. Son muy Utiles para agrupar objetos.

- Camara: es un objeto con un componente camara que sirve para visualizar la
escena. Un personaje en primera persona tendra entre sus componentes una
cdmara que permitira observar la escena como si fuera a través de sus 0jos.

- Luz: es un objeto con un componente Light que se comportara como una fuente
de luz para nuestra escena.

- Objetos Ul (User Interface): permiten al creador de la escena crear interfaces de
usuario. Al mismo tiempo permiten al usuario de la escena o aplicaciéon
comunicarse, obtener informacién a través de dicha interface y modificar el
estado del modelo. Un ejemplo podria ser un texto, una imagen o un botén.

3.2.3. Herramientas béasicas

Para moverse por la escena 3D e interactuar con los objetos se pueden utilizar los
botones de navegacion que se muestran en la figura 3.

- Mano: sirve para desplazarse por la escena.

o +alt. Sirve para mover el punto de vista de la escena (rotacion de la vista).
o +ctrl. sirve para hacer zoom.

- Mover: sirve para mover un objeto sobre alguno de los ejes.
- Rotar: sirve para rotar un objeto sobre alguno de los ejes.

- Escalar: sirve para escalar un objeto sobre alguno de los ejes.

Q@ Ursty Persomal (5404 - Untitfed - New Unity Propect - 9C. Mac & Linux Standaione « 0(1 1
Componert  Wandow Melp

Bl + B ol

* Scene

Assots

Q:Alm Ths falder 1 ety

Figura 3. Botones de navegacion
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3.2.4. Reproduccion de la escena

En la parte superior de la pantalla del editor hay tres botones para ejecutar, pausar o
avanzar en la escena. Esto permite observar el comportamiento que tendra finalmente
la aplicacién que se estd editando. Es recomendable ejecutar la escena a medida que
se va creando para detectar posibles errores.

Una vez terminada la escena, Unity permite exportarla como una aplicacién ejecutable,
pagina web, etc., para que cualquier usuario pueda emplearla.

3.2.5. Los Scripts

Los scripts son un tipo de recurso que permite personalizar el comportamiento de los
objetos mediante programacion. Se afiaden como componente a los objetos. Cuando
un Game Object tiene un componente script, este codigo se ejecuta vinculado al objeto
al que se le ha afiadido. Mas adelante se introducird la programacion en Unity y se
crearan varios ejemplos de este tipo de recursos

3.2.6. Paquetes de recursos

Unity incorpora una serie de recursos o “assets” predefinidos. Se puede acceder a ellos
para importarlos a la escena a través de la pestafia Menu > Assets > Import Package.
Algunos ejemplos de estos recursos son paquetes de vegetacion, de agua, de cielos o
incluso de personajes.

Por otra parte, Unity tiene una libreria de recursos online en la que los desarrolladores
ofrecen los recursos que han creado. Esta libreria se llama Asset Store y se puede
acceder a ella para descargar e importar a la escena los recursos que nos puedan
resultar Gtiles a través de la pestafia Window > Asset Store. Algunos de los recursos
ofrecidos por los desarrolladores son de pago, aunque existe una gran cantidad de ellos
que son gratuitos.

Ambas fuentes de recursos o “assets” simplifican enormemente la modelizaciéon de un
entorno virtual. Para el alcance pretendido en el presente proyecto eliminan una gran
cantidad de tiempo en la creacién de objetos como pueden ser arboles o personajes,
gue nos son objeto principal de la virtualizacion de una obra, y que, sin embargo, llevaria
mucho tiempo crearlos.

3.3. IMPORTAR MODELOS 3D A UNITY

Una de las grandes ventajas a la hora de virtualizar una obra civil es que Unity soporta
la importacién de modelos desde las aplicaciones 3D mas populares, como por ejemplo
Blender o SketchUp asi como también desde los programas de modelado BIM como
Revit.
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Figura 4. Opciones de importaciéon a Unity 3D
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Unity puede leer directamente archivos “.FBX”, “.dae”, “.3DS”, “.dxf’ y “.obj”.

Ventajas:

o Solo se exportan los datos que uno necesita.

o Los datos son verificables (se re-importa en el paquete 3D antes que en
Unity).

o Generalmente son archivos mas pequefios.

o Fomenta un enfoque modular - p. ej. diferentes componentes para tipos
de colisién o interactividad.

o Soporta otros paquetes 3D para cuyo formato Unity no tiene soporte
directo.

Desventajas:
o Puede ser un flujo de trabajo mas lento para la creacion de prototipos e
iteraciones.
o Es mas facil perder la pista de las versiones entre la fuente (archivo de
trabajo) y los datos del juego (por ejemplo, un FBX exportado).

Unity también puede importar mediante conversion archivos, como: Max, Maya,
Blender, Cinema4D, Modo, Lightwave &Cheetah3D, etc.

Ventajas:
o Proceso rapido de iteracion (al guardar el archivo fuente, Unity re-importa
automaticamente).
o Simple de usar al principio.
Desventajas:
o Los archivos pueden llenarse de datos innecesarios.

o Los archivos grandes pueden ralentizar las actualizaciones de Unity.
o Menos validacion, por lo tanto, es mas dificil solucionar problemas.
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3.4. UNITY 3D Y LA REALIDAD VIRTUAL

La Realidad Virtual de Unity (en adelante VR) permite tener como objetivo diferentes
dispositivos de Realidad Virtual sin la necesidad de tener plugins externos. Cuando se
activa el VR en Unity, se automatizan varios procesos como:
La visualizacién estereoscopica automéatica
- Gracias al VR de Unity no se requiere tener dos camaras para visualizaciones
estereoscopias. Las matrices de vista y proyeccion se ajustan para tener en
cuenta el campo de vision.

- Las optimizaciones ocurren automaticamente para que sea menos COStoSO
dibujar frames dos veces (uno para cada 0jo).

Headtracked Automatico

- Se aplica automaticamente el seguimiento de la cabeza (Head Tracking) y se
adapta el campo de vision.

Hay que tener en cuenta que si se quiere modelizar un entorno para el uso de
dispositivos de Realidad Virtual la manera con la que se interactiia con el entorno varia.

A continuacion, se expondra el proceso realizado para virtualizar una obra e interactuar
con ella en tres dimensiones.
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[ 4. VIRTUALIZACION DE UNA OBRA: EJEMPLO PRACTICO |
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4.1. INTRODUCCION

La finalidad del ejemplo practico es realizar una guia para importar un modelo BIM de
un proyecto a un entorno virtual introduciendo la posibilidad de relacionarnos con
nuestro modelo en tres dimensiones a través de la Realidad Virtual.

El principal objetivo es demostrar que se trata de un proceso sencillo, al alcance de
cualquier profesional del sector, una vez que se ha realizado el modelado tridimensional
del proyecto.

Por ello, evitando extendernos en la creacion de un modelo tridimensional de una
estructura, se ha escogido una obra emblematica de la que existen infinidad de modelos
gratuitos en la red.

4.2. LA ESTRUCTRA

Como ejemplo practico se ha escogido el Puente de la Barqueta, localizado en Sevilla,
disefiado por Juan José Arenas de Pablo y Marcos Jesus Pantaledn Prieto y construido
entre 1989 y 1992 para permitir el acceso al recinto de la Exposicién Universal de 1992.

El puente se compone de un arco de acero de 214 metros cuyos extremos forman un
portico triangular en cada lado, atirantado por el propio tablero que tiene una longitud de
168 metros cuyos Unicos apoyos son cuatro soportes verticales a una distancia de 30
metros sobre las orillas del rio Guadalquivir.

4.2.1. 3D Warehouse e importacion a Unity desde Sketch Up
Para la busqueda de un modelo se ha optado por la pagina web “3D Warehouse?”,

propiedad de Sketch Up, ya que es la biblioteca digital de modelos tridimensionales mas
grande del mundo.

22 3D Warehouse Cargarmodelo =

i s
8 Resultados [Tooo Resultados por pagina Clasificar por retevancia
Q )
Z& s =
i s | i &

ADO

|
|
I -

Figura 5. Modelo 3D de la estructura. Se ha seleccionado el modelo realizado por Andrés D.L.

Para importar el modelo desde Sketch Up a Unity primero es necesario abrir el modelo
con Google Sketch Up. Una vez abierto se exporta en formato .dae (Default Settings).

4 Disponible a [05/09/2016] https://3dwarehouse.sketchup.com
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Figura 6. Exportar el modelo en formato .dae en Sketch Up

Tras haberlo exportado abrimos el archivo .dae generado con Blender y lo exportamos
a formato .fbx. Si el modelo se ha realizado con Revit 0 algun otro programa de BIM o
si se ha usado Sketch Up Pro no seria necesario realizar este paso ya que se podria
exportar directamente a un formato .fbx sin necesidad de utilizar Blender.

También existe la opcidn de insertar el modelo de Sketch Up directamente ya que Unity
admite ficheros en formato .dae pero se crearan varios objetos vacios y sera mas dificil
de trabajar con el modelo.

Una vez se tenga el modelo en formato .fbx bien sea porque lo hayamos creado
directamente en ese formato o lo hayamos exportado se recomienda crear una carpeta
llamada Texturas haciendo clic con el boton izquierdo del ratén dentro de la
carpeta Assets acudiendo la pestafia Create > Folder pata tener organizado nuestro
modelo. Una vez creada la carpeta se arrastra o importan las texturas del modelo dentro
de ella. El proceso es el mismo para el modelo .fbx, se crea una carpeta llamada
Estructuras dentro de Assets y se arrastra o importa el modelo.

Gizmos ~ | (orA

Figura 7. Puente de la barqueta importado en Unity
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4.3. CREAR UN TERRENO REAL EN UNITY 3D

Unity es capaz de generar un terreno a partir de un heightmap (en ficheros tipo “.raw”)
gue es un fichero de tipo imagen que representa las elevaciones del terreno en donde
cada pixel representa la elevacion del terreno en ese punto a través de su color (escala
de grises). Un heightmap puede ser de 8-bits y representar altitudes de 0 a 256 o bien
de 16-bits y representar alturas con los valores de 0 a 65536.

4.3.1. Obtencién de datos para representar un terreno real

Para obtener datos reales que definan el terreno en el territorio espafiol se tiene la
informacion que pone a disposicion el Instituto Geogréafico Nacional (IGN) con la base
de datos MDTO5/MDTO05-LIDARS.

Esta base de datos es un modelo digital del terreno (MDT) que contiene la cota de todos
los puntos en una cuadricula de 5 metros de paso de malla. Las coordenadas usadas
para referenciar dichos puntos son coordenadas ETRS89. Este MDT se distribuye
troceado segun la distribucién oficial de hojas 1:25.000.

A la hora de descargar el MDT es necesario localizar cual es la hoja en la que se localiza
la obra. Para localizar dicha hoja, se puede utilizar la Busqueda en visor en la propia
pagina de descargas del IGN que muestra un mapa de Espafia con la distribuciéon en
hojas representada como rectangulos superpuestos sobre el mapa.

Para el ejemplo propuesto, Sevilla est4 ubicada en la hoja denominada 0984. La
superficie abarcada por cada una de éstas hojas es muy grande por lo que sera
necesario definir el area que queremos representar alrededor de la obra. Lo mejor para
importar a Unity es escoger un area de tamafio cuadrado, para el ejemplo escogemos
un cuadrado de lado 1000 m.

Tabla 1. Delimitacion del terreno a modelizar

COORDENADA ETRS89 (H30) NORTE

ESQUINA X (m) Y (m)
SUPERIOR IZQUIERDA 234492 4144471
INFERIOR DERECHA 235492 4143471

4.3.2. Crear el heightmap

Para generar el heightmap a parir del MDT utilizaremos el programa Heightmap
Creator®. El programa extrae los datos de la zona de interés (del fichero tipo “.asc”) que
contiene el MDTO5/MDTO5-LIDAR y los codifica en un fichero de tipo heightmap que
puede ser importado en Unity.

Este programa proporciona como dato de salida la altura maxima del terreno creado que
serd importante recordar para importar el heightmap en Unity 3D.

5 (Centro Nacional de Informacion Geografica - Ministerio de Fomento)
6 (Cuartas Hernandez, 2014-2015)
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Figura 8. Captura de pantalla del programa HC para crear el Heightmap

4.3.3. Importar el heightmap en Unity3D

Para importar el terreno primero serd necesario crear un nuevo proyecto. Una vez
ejecutado Unity es necesario seleccionar la opcidn de crear nuevo proyecto y escoger
la ruta del mismo. Se recomienda guardar la escena que se crea automaticamente al
originar un nuevo proyecto. Para el ejemplo se le ha dado el nombre de Main.

Una vez creado el proyecto es necesario insertar un objeto de tipo terreno a nuestra
escena para poder importar el Heightmap. Para ello se accede al menu en la parte
superior de la pantalla GameObject > 3D Object > Terrain. También se puede
acceder al menu a través de la ventana Hierarchy > Create > 3D Object > Terrain. Una
vez creado se podra ver en el arbol de la escena y al seleccionarlo se mostraran sus
componentes asociados en el Inspector.

Tras crear el objeto, es necesario configurar su tamafio. Para ello es necesario acceder
a la pestafia de configuracion a través de un botén en forma de rosca situado como se
indica en la figura 9. Las dimensiones deben ajustarse al tamafio que se le ha dado al
heightmap, en el ejemplo 1000x1000 y se debe de introducir, también, la altura maxima
del terreno. Este dato se proporciona al crear el heightmap.
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Figura 9. Inspector de un objeto Terrain

Una vez configuradas las dimensiones ya se puede importar el Heightmap a través del
botdn “Import Raw...” en la misma pestafia. Tras pulsarlo sera necesario acceder a la
ruta donde se encuentra el heightmap. Una vez seleccionado, aparece una ventana que
muestra varios datos referentes al mismo, sera necesario comprobar que la profundidad
esta en Bit16, que las dimensiones (Width y Height) son las correcta y que el Byte Order
es Windows.

4.3.4. Referenciar el terreno

Una vez importado el terreno puede ser dificil tener referencias en el mismo para poder
ubicar la obra y modelizar el entorno. Por ello, como referencia, podemos crear un plano
guia recortando una imagen de un mapa del &rea con las dimensiones del terreno y
afiadirla como textura a un objeto plano de las mismas dimensiones como se muestra
en la figura 10. Para crear un plano se accede al menu en la parte superior de la
pantalla GameObject > 3D Object > Plane. Para afadir una textura al plano creamos
una carpeta llamada Textures dentro de la carpeta Assets y arrastramos la imagen
dentro de la carpeta. A partir de ese momento la imagen formara parte de los
recursos del proyecto y podra ser utilizada como textura simplemente arrastrando la
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imagen dentro del elemento en el que queremos que se inserte. Una vez tengamos
el mapa podemos desplazarlo y ubicarlo sobre el terreno para poder ubicar nuestra obra
en planta.

# Scene € Gam: t
Shaded 20- Gizmos 7| (Gr Al )

Figura 10. Terreno y plano de referencia

4.3.5. Anadir texturas, arboles y detalles al terreno

Seleccionando el terreno en la pestafia de Hierarchy, apareceran en la pestafia
de Inspector los componentes que tiene asociados.

© Inspector

I [Terreno | ¥ Static «

Tag | Untagged i| Layer | Default gl

¥ .~ Transform L %
Pasition X 0 |2 'zZlo

Rotation

ELEVACION SUAVIZAR ARBOLES

CONFIGURACION

¥ ¢ ¥ Terrain Collider @ #
Material |None (Physic Material) —| (o]
Terrain Data [\ #New Terrain | @

Enable Tree Colliders [ |
Figura 11. Inspector de un objeto Terrain

Estos componentes son:

- Elevacién del terreno: permite generar elevaciones o eliminarlas si se mantiene
la tecla SHIFT pulsada.

- Altura del terreno: permite generar elevaciones con una altura determinada o
establecer la altura por defecto del terreno.

- Suavizar terreno: permite suavizar los detalles generados con alguno de los
procesos anteriores.
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- Textura del terreno: permite definir y utilizar un conjunto de texturas en el terreno.
Para utilizar una textura es necesario afadirla primero.

- Arboles: permite incorporar arboles al terreno.

- Detalles del terreno: permite definir un conjunto de detalles como césped o rocas
sobre el terreno.

- Configuracion del terreno: permite definir los detalles principales del terreno. Es
la pestafia que se ha utilizado para importar el Heightmap y definir la geometria
del mismo.

Con estas herramientas y el plano guia como referencia se pueden afadir texturas,
vegetacion y detalles al terreno. Para las texturas, los arboles y los detalles es necesario
importar un recurso dentro de los recursos estandar que incorpora Unity. Para importar
el recurso se acude a Assets>Import Package>Environment. Una vez importado, es
necesario afiadir las texturas y arboles en las pestafias correspondientes.

Para afadir una textura es importante saber que la primera textura seleccionada sera la
que adquiera todo el terreno por defecto. Para el ejemplo practico se ha utilizado la
textura “GrasHillAlbeldo” que da un aspecto verde a todo el terreno. Para afiadir una
textura simplemente es necesario seleccionarla en el botén Edit textures>Add texture.
Para el ejemplo se han afiadido algunas texturas mas como una de arena para el fondo
del rio. Si se quiere pintar sobre el terreno con estas texturas secundarias se puede
seleccionar las caracteristicas del pincel como su tamafio o la opacidad de la textura.

Para afadir arboles el proceso es similar, primero es necesario afiadir los elementos en
el botén Edit Tree>Add Tree para posteriormente colocarlos sobre el terreno. De esta
forma afiadimos algunos prefabricados de arbol como: Broadleaf Desktop,
Conifer_Desktop o Palm_Desktop. Para colocarlos sobre el terreno Unity ofrece las
propiedades de tamafio de brocha y densidad de arboles.

Por ultimo, es necesario seleccionar los detalles con los que se quiere pintar el terreno

pulsando en el boton “Edit Details...” y luego “Add Grass Texture”. Para el ejemplo
practico se ha afiadido la textura “GrassFrond01AlbedoAlpha”.
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Figura 12. Antes y después de texturizar el terreno

4.4. MODELIZAR EL ENTORNO

4.4.1. Generacion del cielo

Por defecto, al crear un nuevo proyecto, Unity ofrece un material para el cielo
(Skybox) predefinido. Para dar un aspecto mas realista se puede acudir a la tienda de
assets (Asset Store) donde se encuentran materiales para el cielo gratuitos de mejor
calidad que el predefinido por Unity.

Para descargarlos es necesario acceder a la pestafia Asset Store (ubicada como se
indica en la figura 13). En la Asset Store hay cuadro de busqueda que nos permite
buscar un recurso a través de su descripcion, en este caso “skybox” y la opcion de
buscar recursos unicamente gratuitos. En el ejemplo se ha utilizado el asset “Classic
Skybox”. Una vez seleccionado es necesario descargar el paquete e importarlo. Al
hacerlo lo encontraremos en una carpeta en la pestafia Assets.

Por tanto, el proceso para descargar recursos gratuitos es muy sencillo. A partir de este
punto se recomienda el uso de la Asset Store para mejorar el aspecto de la escena. Por
ejemplo, el paquete estdndar que ofrece Unity para texturizar el terreno puede resultar
escaso y se recomienda la bUsqueda de paquetes con vegetacion para dar mas
variedad y realismo al entorno.
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Figura 13. Asset store

Para cambiar el Skybox, es necesario dirigirse al menu Window > Lightning > Scene e
incorporar el cielo descargado. El paquete de materiales para cielo importado nos
proporciona una amplia lista de cielos. Lo recomendable es probar con diferentes cielos

para elegir el que mejor ilumine la escena creada, para el ejemplo practico se ha elegido
el “skybox09”.

# Scene
Shaded

Figura 14. Vista del cielo importado

4.4.2. Generacion del agua

Para afiadir el agua del rio Guadalquivir es necesario importar un asset dentro de los
recursos estandar que incorpora Unity. El recurso necesario es el de Environment, que
ya habiamos importado para afadir nuestras texturas y arboles al terreno. Por ello, se
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encuentra en la carpeta de nuestro proyecto Assets > Standard Assets > Environment
> Water > Water > Prefabs > WaterProDaytime. Es muy sencillo ubicarlo en la escena,
simplemente es necesario arrastrarlo sobre la misma. Una vez en la escena sera
necesario ajustar su tamafio y posicién para que coincida con la depresion en el terreno
formada por el rio.

# Scene
Shaded

Figura 15. Vista del terreno con texturas, arboles, cielo y agua.

Al ejecutar la aplicacion con las Gafas de Realidad Virtual se recomienda cambiar la
opcién Water Mode (situada en el Inspector del objeto) a “Simple” lo que renderizara el
agua sin reflejo y con un aspecto azulado. Esto se debe a que este objeto no esta creado
para el uso de gafas de Realidad Virtual, si no para mostrarlo en una pantalla. Por lo
que la vision estereoscopica del mismo no esta ajustada y al observar el agua crea una
sensacion incomoda al usuario.

4.4.3. Anadir la estructura

Una vez se ha creado el entorno afiadir la estructura es un proceso muy simple. Es
necesario simplemente localizar dentro de la carpeta “Assets” del proyecto la carpeta
gue se ha creado con anterioridad llama Estructuras donde se encuentra el puente en
formato .fox. Una vez localizado el puente lo mas sencillo es arrastrarlo a la escena y
ubicarlo en la misma con ayuda de nuestro mapa.

Asi habremos conseguido componer nuestra escena con los elementos principales de
la misma como se muestra en la figura 16.
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Figura 16. Escena con la estructura.

4.4.4. Anadir alineaciones

Para componer la escena es interesante afiadir las alineaciones del paseo que bordea
la vereda del rio, asi como la carretera de acceso al puente. Para ello se recomienda el
uso de assets gratuitos disponibles en la Asset Store. Existen dos opciones para
componer las alineaciones:

- Paguetes de recursos con objetos prefabricados con forma de trozos de
carretera. Puede descargarse paquetes de recursos compuestos por trozos de
carretera rectos, con giros a derecha e izquierda, rampas, etc. E ir afadiendo
dichos prefabricados a la escena componiendo las alineaciones. Dichos
prefabricados vienen con texturas predefinidas que pueden modificarse. Si las
alineaciones que se quieren crear no son muy extensas puede ser un recurso
valido y facil de usar.

- Paquetes de recursos con una herramienta para la creacion de alineaciones. Por
ejemplo, existe el paquete “RoadTool” que permite crear alineaciones
simplemente pulsando la combinacién de teclas shift + R. Una vez ejecutado es
necesario marcar los puntos por donde se quiere pasar la alineacion. El unico
inconveniente es que el terreno sobre el que se quiera dibujar la alineacion debe
de estar nivelado para poder dibujar la carretera.

Para el ejemplo préactico se ha escogido el segundo recurso previo acondicionado del
terreno. Para dicho acondicionado se ha usado la opcién “Altura del terreno” en el
Inspector del objeto tipo terreno marcando una altura fija de 4 m para el paseo en la
vereda del rio y de 12 m para la carretera de acceso al puente.
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Figura 17. Creacion de alineaciones gracias al recursos "RoadToll" disponible en la Asset Store de Unity

Para crear la alineacién es necesario que esté pulsado el botén “Move” de interaccién
con la escena (segundo por la izquierda).

Una vez creada la alineacion es posible ajusta el ancho y afiadirle la textura o material
gue se desee. Si se desea editar la alineacion simplemente se debe seleccionar e objeto
creado en el arbol del editor y darle al boton “Modify” del Inspector.

También pueden afiadirse nuevos puntos a la alineacion una vez seleccionado el boton
“Modify”. Estos puntos se afiadiran por defecto a continuacion del ultimo nodo creado.
Si se quiere crear un nodo al comienzo de la alineacion habrd que cambiar el parametro
del Inspector “Insert At Point” de -1 a 0.

- | Default

MODIFICAR EL ANCHO DE LA
ALINEACION

d (Script)

h

ANADIR NUEVOS PUNTOS (-1
PARA CONTINUAR AL FINAL DE
LA ALINEACION, 0 PARA
ANADIR PUNTOS AL
COMIENZO DE LA MISMA)

Figura 18. Inspector de los objetos creados con el recurso "RoadTool"
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4.45. Aiadir audio de ambiente

Como el proyecto se encuentra ubicado préximo al rio Guadalquivir lo [6gico seria afiadir
un clip de audio que simulase el ruido que hace el rio. Para ello existen en Internet bases
de datos con sonidos de todo tipo, una vez descargado un clip de audio con un sonido
de rio se guarda en una carpeta, que se ha creado previamente en la carpeta de Assets,
con el nombre de Audios.

Para afadir el audio se selecciona el elemento que emite el sonido, en este caso el rio,
y se le afade un componente de tipo Audio > Audio Source. Una vez afiadido el
componente es necesario arrastrar el clip a la ventana Audio Clip. Es importante ejecutar
la escena a medida que se va creando la misma para comprobar el funcionamiento de
los objetos, por ejemplo, se puede ajustar el volumen del audio para que se convierta
en un ruido ambiental.

4.5. INTERACCION CON EL ENTORNO

Una vez creado el entorno el siguiente paso es posibilitar la interaccion con el mismo.
Aunque a priori pudiera parecer un proceso complejo, Unity lo simplifica al ofrecer un
paquete de recursos estandar con personajes. Esto quiere decir que, de una manera no
muy compleja, se puede afadir personajes que nos permiten interactuar con la escena.

4.5.1. Personajes

Unity ofrece un paquete de recursos con dos tipos de personajes que se diferencian
segun el punto de vista:

- Personaje en tercera persona: Al ejecutar la escena la cAmara se sitla sobre el
personaje de manera que se participa en la escena como observador. La
interaccion con la escena es posible gracias al control sobre el movimiento del
personaje.

- Personaje en primera persona: Al ejecutar la escena la camara simula la visién
del personaje. Este tipo de personaje es el apropiado para la Realidad Virtual ya
que el objetivo es permitir que el usuario se sumerja en la escena creando la
sensacion de estar presente en ella.

Para utilizar este recurso es necesario importarlo, lo encontramos en Assets>Import
Package>Characters. Una vez importado se habrd creado una carpeta ubicada en
nuestro proyecto en Assets>Standard Assets>Characters>FirstPersonCharacter. El
objeto prefabricado que afiadiremos en la escena estara compuesto por muchos
componentes como una camara, un receptor de audio, o un script que controla el
movimiento.
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# Scene
Shaded

P20 Cold

Free Aspect

Figura 19. Diferencias del punto de vista de la camara entre tercera persona (imagen superior) y primera
persona (inferior)

Unity ofrece dos controladores en primera persona. Para ajustar la aplicacion a el uso
de Realidad Virtual se recomienda el uso del Rigid Body FPC ya que no simula los pasos
de una persona (lo que puede crear una sensacion incomoda para el usuario) y ademas
adapta los ejes de movimiento a la direccién a la que se enfoca lo que es esencial para
el usuario de dispositivos de Realidad Virtual.

Para incorporar el personaje principal es necesario afiadir el modelo prefabricado Rigid
Body FPC a la escena. Para afiadir este elemento en la escena bastara con buscarlo en
la carpeta StandardAssets >Characters > First PersonCharacter > Prefabs y arrastrarlo
a la misma. Por ultimo, serd necesario colocarlo en el punto en el que se quiera situar
el personaje al comienzo de la aplicacion. Siempre que se ejecute el programa se
comenzara en dicho punto, a partir del cual el usuario podra moverse libremente por la
escena.

Es importarle dar un nombre al personaje principal ya que éste va a interactuar con otros
objetos y sera necesario diferenciarlo a la hora de programar el comportamiento de los
objetos ante él. Para este ejemplo préctico se ha escogido el nombre “Player”.

Una vez creado el personaje es muy importante ejecutar la aplicacion y experimentar la
sensacion de moverse a traves del espacio. Se recomienda ajustar la altura de la
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camara a unos 1.4 metros sobre el suelo que es la altura media de la mirada. Si no se
realiza esta operacion se podria estar creando una aplicacidon que provocase malestar
sobre el usuario.

A su vez, para combatir la cinetosis, es necesario ajustar la velocidad con la que se
desplaza el usuario por la escena. Para ello se acude al Inspector del personaje y se
modifica las velocidades en los ajustes de movimiento (Movement Settings). Tras
experimentar diferentes velocidades se recomienda ajustar todas las velocidades, como
maximo, a dos.

45.2. Como modificar la configuracion para controlar al
personaje

Unity utiliza como input el teclado y el ratdn para controlar el movimiento del personaje
por defecto. Para mover el personaje alrededor de la escena se utilizan las flechas. Para
mover la camara, es decir, enfocar la vista se utiliza el raton o si se tiene activada la
opcion de Realidad Virtual simplemente es necesario mover la cabeza.

Para visualizar la obra en tres dimensiones no es necesario levantarse de la silla o
alejarse del teclado por lo que la opcién para moverse por la escena con las flechas del
teclado es suficiente.

El casco de Realidad Virtual con el que se cuenta para ejecutar ese proyecto, el set
Oculus RIift, incluye un mando de la Xbox One inalambrico que pude usarse para
desplazarse por la escena, lo que permite alejarse del ordenador o posicionarse
levantado mientras se interactla con la escena. Si se quiere configurar el mando es
necesario acudir a Edit > Project Settings > Input.

En el mencionado apartado puede seleccionarse que botones controlan el movimiento
del personaje. Hay que prestar especial atencion a que plataforma objetivo estara
orientada la aplicaciéon que va a crearse ya que la numeracion de los ejes es diferente
en PC, Mac o Linux.

Una vez creada la aplicacién, al ejecutarla, la ventana de inicio de la misma permite
cambiar la configuracién del input para que una misma aplicacion sirva para diferentes
controles.

Tabla 2. Controladores para el mando de la Xbox One

MANDO XBOX ONE WINDOWS

Boton A joystick button 0
Boton B joystick button 1
Boton X joystick button 2
Boton Y joystick button 3
Boton LB joystick button 4
Boton RB joystick button 5
Boton ATRAS joystick button 6

Boton START

Stick izquierdo
Stick derecho

Horizontal

joystick button 7
joystick button 8
joystick button 9
X axis
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Vertical Y axis
Giro horizontal 4th Axis
Giro vertical 5th Axis
Flechas - horizontal 7th Axis
Flechas - vertical 8th Axis
Boton LT 9th Axis
Boton RT 10th Axis

Con ello se puede definir el boton o eje que se quiera para cada movimiento.

4.5.3. Geometriay fisica en Unity 3D

Una vez construido el modelo en Unity con la opcion de Realidad Virtual activada la
plataforma permite directamente desplazarse por la escena, acercarse a la estructura y
verla desde cualquier angulo.

El siguiente paso es crear una forma de interactuar con los objetos dentro de la escena.
Para este capitulo del proyecto serd necesario un conocimiento basico en programacion.
Para el desarrollo del proyecto se ha optado por utilizar el lenguaje de programacion C#.

En la Realidad Virtual existen dos formas comodas y naturales para interactuar con
objetos: acercarnos a ellos o mirarlos. Pero antes de avanzar con el desarrollo del
ejemplo se van a introducir una serie de componentes de los objetos en Unity que
facilitaran la explicacién posterior.

Un objeto en Unity se forma a partir de componentes, entre los que destacan:

- Rigidbody: Los Rigidbodies permiten a sus GameObjects actuar bajo el control
de la fisica. El Rigidbody puede recibir fuerzas o colisiones con otros objetos
para hacer que el objeto asociado se mueva de una manera realista. Cualquier
GameObject debe contener un Rigidbody para ser influenciado por gravedad o
por fuerzas externas afadidas mediante cédigo

- Collider: son componentes que afiaden geometria de colisién al objeto, es decir,
permiten al objeto al que se le aflade reaccionar ante otros objetos que también
tengan una componente Collider siempre y cuando alguno de ellos tenga un
componente Rigidbody. Es como una malla que se coloca alrededor del objeto y
que define su area de interaccion. Tiene tres formas primitivas: una esfera, una
capsula y una caja y se muestran en la escena mediante lineas verdes. Para
darle formas mas complejas se puede usar el componente Mesh Collider que se
adaptard a la forma que tenga el objeto. Cuando dos objetos con componentes
Collider interactian ocurre un evento por lo que la manera en que se comportan
ambos objetos al interactuar puede ser programada mediante un Script.

El componente Collider tiene una opcion para que el motor de fisica no tenga en
cuenta los choches del colisionador de forma automética y, a cambio, dispare un
evento para que pueda tratarse por codigo (seleccionando la opcion “Is Trigger”
en el Inspector). Cuando un Collider tiene esta opcién activada las cosas no
chocan contra la malla, sino que pueden pasar a través de ella y esto puede ser
detectado en cédigo. Es decir, no s6lo podemos usar este componente para la
colision de dos objetos macizos si no que puede utilizarse como un elemento
vacio que permita interactuar con la escena. Un ejemplo seria para registrar
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cuando un balén cruza una porteria. En el plano del larguero podria utilizarse un
componente Collider con la opcién “Is Trigger’ que detectase cuando el balén
traspasa la porteria sin interferir con la trayectoria del mismo.

Observando los elementos del personaje principal que hemos afiadido a la escena
podemos comprobar que entre sus componentes se encuentra:

- Un componente Rigidbody que permite simular el movimiento real del personaje,
por ejemplo.

- Un Collider en forma de capsula que limita el area de interaccion del personaje.
- Un Script que controla los movimientos del personaje.

- Ademas, tiene asociado un objeto tipo camara que sirve de ojos a la hora de
visualizar la escena.

4.5.4. Objetos Ul (User Interface)

Ul se refiere a la interfaz de usuario que se muestra de manera bidimensional en una
aplicacion y que proporciona informacion al usuario como pueden ser textos, imagenes
o controles tipo botoén.

En Unity los objetos tipo Ul siempre se disponen sobre un objeto Canvas o lienzo que
representan un espacio abstracto sobre el que yace un objeto tipo Ul y sobre el que se
renderiza. Por lo que cuando se quiera afadir un objeto Ul éste debera ser dependiente
de un lienzo.

En las aplicaciones de Realidad Virtual los objetos Ul no pueden implementarse de
manera tradicional, es decir, como un plano que forma parte de la pantalla sobre el que
el usuario puede realizar acciones. Por lo que para utilizar este tipo de elementos en
aplicaciones destinadas a la Realidad Virtual sera necesario ubicarlos como un objeto
mas en la escena.

En funcién de cuando y dénde se quiera ofrecer la informacién, estos objetos pueden
disponerse de dos maneras distintas:

- Enfrente de la camara con independencia de hacia donde mire el usuario.

- En un emplazamiento concreto del entorno 3D, siendo visibles si el usuario mira
en esa direccion.

Para que un lienzo forme parte de la escena es necesario activar la opcién “world space”
en el Render Mode de su Inspector.

Debido a que éste tipo de objeto es el que va a usarse en los proximos capitulos para
interactuar con la obra, se recomienda crear un lienzo por defecto que nos servira como
base. Para ello lo primero que hay que hacer es crear un lienzo a través de Window >
GamObject > Ul > Canvas. Para el ejemplo practico se le ha dado el nombre de
DefaultCanvas. Una vez creado, se activa la opcién “world space” en el Render Mode
de su Inspector.
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El componente Rect Transform define la malla como si fueran los cuadrados de una
libreta. Se usa para colocar los objetos Ul sobre él. Por defecto le daremos unas
dimensiones de 640 x 480 con una relaciébn de 0.75. Le daremos una escala de
(0.00135, 0.00135, 0.00135) que es el tamario de un pixel en el espacio de la escena.
Por ultimo, centraremos el lienzo en el terreno.

Una vez ubicado, se le afiadira un objeto Ul tipo imagen blanca que ayudard a visualizar
el lienzo cuando se necesite. Para ello se accede a Window > GamObiject > Ul > Image.
Es necesario asegurarse de que la imagen esta vinculada al Lienzo. Una vez afiadida
en el Inspector sera necesario modificar el Anchor Presets a strech-strech.

Por altimo, se le afiadira un objeto Ul tipo texto a través de Window > GamObject > Ul
> Text al que le daremos las siguientes propiedades: Anchor Presets a strech-strech,
escala (4,4,4) y alineacion centrada.

irder in Layer

[Z] & canvas Scaler (Script)

Dynamic Pixels Per Lnit
Reference Pixe

4 ¥ Graphic Raycaster (Script)

e T Graphics

Figura 20. Inspector con valores de referencia para el Ul de referencia

Una vez afadido el texto puedo observarse que aparece bastante distorsionado por lo
que se recomienda modificar las propiedades del lienzo. Cambiaremos el Dynamic Pixel
Per Unit a 10.

Este sera el objeto U que servira como base para todos los objetos IU que queramos
afadir. Es recomendable guardar el objeto en una carpeta creada previamente llamada
Prefabs arrastrando el objeto a la carpeta.

4.5.5. Introduccién a la programacion
Unity es capaz de realizar muchas actividades como administrar los objetos,
renderizarlos, animarlos o calcular la fisica que los afecta. Esto implica que Unity es un
programa por si mismo y que por lo tanto estara construido por cédigo. Este cédigo
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interno es accesible a través de la interfaz del editor (API) que se ha estado utilizando.
En dicha Interfaz los scripts se muestran como componentes que se pueden configurar.

Como lenguaje de programacion Unity se basa en el lenguaje C#, cuando se utiliza un
lenguaje de programacion es muy importante obedecer la sintaxis del mismo. Si al crear
un script Unity detecta algun error lo muestra a través de la ventana Console.

El programa incorpora un editor de cédigo llamado Visual Studio de Microsoft aunque si
se cuenta con algun otro editor éste puede ser utilizado.

En un C# script de Unity algunos simbolos y palabras son parte del lenguaje C#, otros
son parte de Microsoft .NET Framework y otros son proporcionados por la API de Unity.
Cuando se crear un nuevo script en €l aparece el siguiente codigo:

using UnityEngine;
using System.Collections;

public class NewBehaviourScript : MonoBehaviour {

/I Use this for initialization
void Start () {

}

/I Update is called once per frame
void Update () {

}
}

Las dos primeras lineas indican que el script necesita otras librerias de cddigo para
ejecutarse. La palabra using pertenece al lenguaje C#. La linea using UnityEngine; dice
que se estara usando la libreria UnityEngine de la interfaz del programa. La linea using
System.Collections; permite usar libreria de funciones relacionadas con el manejo de
colecciones del .Net Framework..

En C# cada linea de cédigo acaba en un punto y coma. La doble linea // permite afiadir
comentarios ya que todo lo que se encuentre detras de la doble linea seréa ignorado al
ejecutar el script.

Para facilitar la tarea de programar existen las clases que son como plantillas de cédigo
con sus propias propiedades (variables) y comportamiento (funciones). Estas clases
derivan del MonoBehaviour. Luego una clase define las variables y las funciones. Una
variable contiene datos de un tipo especifico. Las funciones permiten implementar la
l6gica, es decir, permiten definir las instrucciones paso a paso. Dichas funciones pueden
recibir argumentos y pueden devolver nuevos valores cuando son ejecutadas.

Cuando se declara un miembro de una clase como publico puede ser visto y usado por
otro codigo en otro script, sin embargo, cuando es privado sélo puede ser Dentro de la
misma clase donde se define.

Unity permite invocar funciones-mensaje especiales si se las define. Un ejemplo de ello
son las funciones Start () y Update () incluidas en el cédigo por defecto de un script en
Unity. Delante de las funciones se define el tipo de valor que devolvera. Cuando una
funcion no devuelve un valor incluyen la palabra clave void como tipo de retorno.

Pagina 37 de 62



REALIDAD VIRTUAL EN LA INGENIERIA CIVIL

La funcion Start () se ejecuta antes de que comience la escena por lo que se usa para
dar instrucciones iniciales. La funcién Update () es ejecutada al mismo tiempo que la
escena. El tiempo es dividido en frames y en cada frame se ejecuta la funcién.

Una vez se haya escrito o modificado un script, es necesario guardarlo. Una vez
guardado se podra observar en la ventada Console si Unity detecta algan error en él.

Esto es s6lo una pequenia introduccién a la programacién en Unity, en los ejemplos que
siguen se explicara el funcionamiento del codigo creado.

4.5.6. Programar un objeto para que aparezca cuando el usuario
se aproxima: carteles interactivos

Una de las formas intuitivas con las que interactuar con un objeto en la Realidad Virtual
es acercandonos a él. En este ejemplo practico se va a realizar un codigo para que
varios objetos tipo texto aparezcan dinamicamente a medida que el usuario se desplaza
por la escena.

Primero es necesario colocar un Empty Game Object con un componente Collider en
las zonas dénde se quiere que aparezcan los textos. Marcamos la opcion “Is Trigger”
para que el colisionador desencadene el evento cuando nos acerquemos a él. Una vez
se ha colocado el Game Object con su componente Collider le daremos el nombre de
Activador.

COLLIDER con la
opcion “Is Trigger”
activada

UBICACION

Figura 21. Empty Game Object al que se le ha afiadido un componente collider esférico.

El siguiente paso es crear el cartel, para ello se utilizara el lienzo que se ha construido
en el apartado anterior ubicado en Assets>Prefabs>DefaultCanvas. Para incorporarlo a
la escena simplemente es necesario arrastrarlo hasta la ubicacion deseada (detras del
activador).

Para el ejemplo se ha escrito el siguiente mensaje de bienvenida “BIENVENIDO AL
PASEO INTREACTIVO POR EL PUENTE DE LA BARQUETA”y se le ha afadido otro
componente tipo texto para afiadir en un tamafio de letra mas pequefio: “Puedes
moverte libremente por la escena. Encontraras carteles informativos y alguna sorpresa
escondida jDiviértete!”.
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BIENVENIDO AL PASEO

INTERACTIVO POR EL
PUENTE DE LA BARQUETA

Puedes moveta koo wonle po!

16 sacend . Enconiaaas camees

wdocrmnatives y aguna SONINEND
guoondda

(D riots)

Figura 22. Cartel de bienvenida

Una vez creados los dos elementos es necesario programar un Script asociado al
Activador para que cuando el personaje principal entre en contacto con el Collider se
active el cartel y que cuando salga se desactive.

Unity pone a disposicion del usuario, a través de su pagina web, una gran base de
ejemplos précticos y tutoriales que sirven como herramienta de aprendizaje. Asi mismo,
en la esquina superior derecha de cada componente hay un icono de un libro con una
interrogacion que nos lleva a la ayuda online de Unity dénde nos explican todas las
propiedades del componente. Esto sirve de gran ayuda a la hora de programar Scripts
para el funcionamiento de los objetos porque sabremos que propiedades se vinculan a
cada componente del objeto.

Para crear el script primero es recomendable crear una carpeta y nombrarla Scripts.
Dentro de la carpeta haciendo clic sobre el boton derecho se selecciona la opcion
Create> C# Script y se le da un nombre al fichero. En el ejemplo TextoDescriptivo. Una
vez creado se hace doble clic en él para abrir Visual Studio de Microsoft de Unity donde
se podré escribir el siguiente codigo:

using UnityEngine;

using System.Collections;
using UnityEngine.Ul,

public class ActivarTexto : MonoBehaviour

{

public GameObject TextoDescriptivo;

void Start()
{
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TextoDescriptivo.SetActive(false);

}

void OnTriggerEnter(Collider other)

{

}

if (other.gameObject.name == "Player")

{
}

TextoDescriptivo.SetActive(true);

void OnTriggerExit(Collider other)

{

}
}

{
}

if (other.gameObject.name == "Player")

TextoDescriptivo.SetActive(false);

El funcionamiento del script es el siguiente:

Primero se hace publica la variable de tipo TextoDescriptivo que sera aquel
objeto que aparecera al acercarnos. De esta forma serd visible en el Inspector
de Unity y podremaos asignarle un objeto presente en la escena.

Luego, antes de iniciar la escena, se asegura que dicho objeto esta desactivado.

Al iniciar la escena se utiliza una funcién que detecta cuando un objeto ha
entrado en el &rea encerrada por el Collider del objeto al que se le aflade el script
y ademas se le afiade la condicién de que si el objeto que entra en contacto es
el jugador, que active el objeto al que hemos llamado TextoDescriptivo.

Por ultimo, se utiliza una funcién que detecta cuando un objeto ha salido del area
definida por el Collider al que se le afiade el script. Incluyendo la condicién de
que si el objeto que sale del mismo es el jugador, que desactive el objeto al que
hemos llamado TextoDescriptivo.

Como podemos ver se han utilizado las siguientes funciones:

OnTriggerEnter: reconoce cuando otro objeto con un elemento Collider (y un
Rigid Body) entra en la malla del Collider con la opcién “Is Trigger” activada al
gue se le afiade el Script.

OnTriggerExit: reconoce cuando otro objeto con un elemento Collider (y un
RigidBody) sale del interior de la malla del Collider Trigger al que se le afiade el
Script.

gameObject.SetActive(true/false): activa si (true) o desactiva (false) al objeto que
invoca.
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Es importarte que se invoque al personaje en primera persona por el nombre que se le
haya dado. En el ejemplo se ha usado el nombre de “Player”. Como puede verse en el
Script, condicionamos el comportamiento del cartel a la entrada del objeto “Player”.

Una vez creado el Script se le afiade al Activador. Para afadir el Script basta con
arrastrar el fichero al objeto dentro del &rbol del proyecto o afiadirlo como componente
en el Inspector (una vez seleccionado el objeto).

Cuando se haya afiadido el Script en la pestafia del Inspector, éste preguntara por el
objeto al que se le quiere llamar “Texto Descriptivo” y que sera el que aparezca y
desaparezca cuando se entre en contacto con el Collider. Por lo que se selecciona el
Lienzo que contiene el texto y se arrastra a la ventana como se muestra en la siguiente
figura.

I de segundo cartel
efault
) Transform
Position

tion

- . - 2
v Sphere Collider

£ | Edit Collider
v

None (Physic Material)

Activar Texto (Script)
La ventana nos pide el objeto
xto Descriptivo 29 que queremos que aparezca y
desparezca

Figura 23. Script afiadido como componente al objeto Collider y ventana que nos pide el objeto al que se
invoca en el Script

Se recomienda ejecutar la escena para comprobar el funcionamiento del Script. Si éste
no funcionase habra que revisar que el nombre del personaje principal de la escena
coincide con el invocado en el Script y que éste contiene un componente Rigid Body,
otro posible fallo es no haber activado la funcién “Is Trigger” en el objeto con el
componente Collider que funcionara como activador.

Para que la experiencia de usuario sea mas comoda se recomienda que el cartel
siempre se oriente a la camara para ello se puede escribir el siguiente script:

using UnityEngine;
using UnityEngine.Ul;
using System.Collections;

public class LookMoveTo : MonoBehaviour {

public GameObject terreno;
public Transform cartel;

void Start ()
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void Update () {

Transform camera = Camera.main.transform;
Ray ray;

RaycastHit[] hits;

GameObject hitObject;

ray = new Ray(camera.position, camera.rotation * VVector3.forward);
hits = Physics.RaycastAll(ray);

for (int i=0; i< hits.Length; i++)
{
RaycastHit hit = hits[i];
hitObject = hit.collider.gameObiject;

if (hitObject == terreno)

{
cartel.LookAt(camera.position);
cartel.Rotate(0.0f, 180.0f, 0.0f);
}
}
}
}

El funcionamiento del script es el siguiente:

- Primero se hacen publicas las variables terreno y el cartel para que se puedan
escoger a través del Inspector.

- Luego se crean unas variables para referirse a la camara, al rayo de visién
central, y al objeto sobre el que colisionara asi como la propia colisién. Tras lo
gue se define el rayo en funcién de la posicion de la camara y la colisién de éste
con cualquier elemento.

- Lo siguiente es definir el comportamiento de los objetos. Se utiliza un ciclo for
para proyectar el rayo y registrar si colisiona con un objeto.

- Por udltimo, se define el comportamiento en caso de que el rayo colisione con el
cartel. Cuando el rayo colisione con el terreno, es decir, cuando no se esté
mirando al cartel, éste se orientar4 hacia la cdmara a través del comando
“LookAt”. El resultado de dicho comando es que el cartel estard enfocado hacia
la direccién de la mirada cuando el usuario vuelva a mirarlo por lo que es
necesario rotarlo 180 grados alrededor del eje y.

Este script es muy interesante ya que introduce la forma de interactuar con los objetos
al mirarlos.

Tras crear el script seré necesario afladirlo como componente al personaje en primera
persona y arrastrar hasta la ventana “Terreno” el objeto terreno y a la ventana “Cartel”
el cartel que queremos que se oriente en el Inspector. Si queremos que mas de un objeto
se oriente, por ejemplo, todos los carteles sera necesario afiadirlos en el script de la
siguiente manera:
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using UnityEngine;
using UnityEngine.Ul;
using System.Collections;

public class LookMoveTo : MonoBehaviour {

public GameObject terreno;
public Transform cartell;
public Transform cartel2;
public Transform cartel3;

void Start ()
{

}
void Update () {
Transform camera = Camera.main.transform;
Ray ray;
RaycastHit[] hits;
GameObject hitObject;

ray = new Ray(camera.position, camera.rotation * VVector3.forward);
hits = Physics.RaycastAll(ray);

for (int i=0; i< hits.Length; i++)

{
RaycastHit hit = hits[i];
hitObject = hit.collider.gameObject;
if (hitObject == terreno)
{
cartell.LookAt(camera.position);
cartell.Rotate(0.0f, 180.0f, 0.0f);
cartel2.LookAt(camera.position);
cartel2.Rotate(0.0f, 180.0f, 0.0f);
cartel3.LookAt(camera.position);
cartel3.Rotate(0.0f, 180.0f, 0.0f);
}
}
}
}

Asi podremos incluir todos los carteles necesarios y orientarlos hacia el usuario. Para
el ejemplo se han afiadido otros dos carteles, uno con la historia del puente y otro para
informar del siguiente apartado.

Por ultimo, se ha incluido un cartel con el titulo del proyecto que se activara una vez

que el usuario se posicione encima del puente. Este aparecera en el horizonte y sera
de gran tamairio.
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4.5.7. El cambio del puente

En el presente apartado se propone realizar un cambio en el modelo del puente. Una
vez que el personaje haya dejado el puente a sus espaldas, al girarse, podra ver un
modelo simplificado de como viajan las fuerzas en el puente.

Para ello primero es necesario construir un modelo tridimensional con el esquema de
fuerzas. Para el ejemplo practico se ha modificado la geometria original del puente en
Sketch Up. Una vez construido el modelo e importado a Unity siguiendo los pasos del
apartado 4.2.1 se emplazara en el mismo lugar que el puente original.

Lo siguiente sera crear un Objeto con un elemento Collider con la opcién “Is Trigger”
seleccionada y colocarlo como Activador en el punto en el que se quiera cambiar un
puente por otro. Se le dara una dimension importante para que el personaje pueda ver
el esquema del puente al mismo tiempo que se desplaza por la escena.

Una vez creado el Activador es necesario adjuntarle un script que detecte la entrada del
personaje, y que cuando esto ocurra active el modelo del esquema del puente y
desactive el modelo del puente real.

Seir4 ala carpeta Scripts dentro de la carpeta Assets y calcando sobre el botdn derecho
se seleccionara la opcién Create> C# Script y se le dara un nombre al fichero. En el
ejemplo CambioPuente. Una vez creado se hace doble clic en él para abrirlo donde se
podra escribir el siguiente codigo:

using UnityEngine;
using System.Collections;
using UnityEngine.Ul;

public class CambioPuente : MonoBehaviour

{

public GameObject PuenteReal;
public GameObject EsquemaPuente;

void Start()
{

}

EsquemaPuente.SetActive(false);

void OnTriggerEnter(Collider other)

if (other.gameObject.name == "Player")

{

PuenteReal.SetActive(false);
EsquemaPuente.SetActive(true);

}
}

void OnTriggerExit(Collider other)
{

if (other.gameObject.name == "Player")
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{

PuenteReal.SetActive(true);
EsquemaPuente.SetActive(false);

El script es parecido al de los carteles interactivos y funciona de la siguiente manera:

- Primero se hacen publicos los objetos PuenteReal y EsquemaPuente para que
se puedan escoger a través del Inspector.

- Luego, antes de iniciar la escena, se asegura que el objeto EsquemaPuente esta
desactivado.

- Al iniciar la escena se utiliza una funcion que detecta cuando un objeto ha
entrado en el &rea encerrada por el Collider del objeto al que se le afiade el script
y ademas se le afiade la condicién de que si el objeto que entra en contacto es
el jugador, que active el objeto al que hemos llamado PuenteReal.

- Por altimo, se utiliza una funcién que detecta cuando un objeto ha salido del area
definida por el Collider al que se le afiade el script. Incluyendo la condicién de
que si el objeto que sale del mismo es el jugador, que desactive el objeto al que
hemos llamado PuenteReal.

Una vez creado el Script, sera necesario afiadirlo como componente al objeto Collider y
arrastrar dentro del Inspector el modelo del puente en la ventana PuenteReal y modelo
del esquema del puente en la ventana EsquemaPuente como se indica en la siguiente
figura.

- ' Default

B cube (Mesh Filter)
¥ V' Box Collider
n

b | Edit Collider
vy

Ventanas donde anadir nuestros modelos

SQUEMA PUENTE

Script afiadido al objeto Collider

Figura 24. Componente Script afiadida al objeto Collider

Una vez terminado el proceso, al ejecutar la escena, y tras haber desplazado hasta el
otro lado del puente ya no se observara el puente real si no un esquema del mismo.
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4.5.8. Botones

En el presente apartado se introducira el uso de los objetos tipo botén los cuales
permiten interactuar con la escena.

4.5.8.1. Creando el panel con los botones

El botdn en Unity viene integrado como un elemento Ul (User Interface) por lo que para
insertar un botén en la escena sera necesario tener un lienzo. Una vez creado el lienzo
a través de la pestafia Create > IU > Canvas se afiade un botén asociado al lienzo a
través de Create > |U > Button. Para ello puede utilizarse como lienzo el prefabricado
generado en apartados anteriores. Para desplazar los botones hasta el comienzo del
puente basta con mover el lienzo ya que se sitian sobre él, lo mismo pasa con las
dimensiones. Es importante recordar que si se quiere que el botén aparezca como un
objeto fisico en la escena, es necesario seleccionar la opcion World Space en el Render
Mode del lienzo.

El objeto botén en Unity esta disefiado para iniciar una accién cuando el usuario hace
clic y lo suelta. Si el mouse se mueve del control del botén antes de que el clic se haya
soltado, la accion no toma lugar.

En el Inspector una vez seleccionado el boton se observa el siguiente componente:
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¥ '\:'S,' [ Button (Script) =,
Interactable [+
Transition | ColorTint ™
Target Graphic 1 [Button {Image) o
Mormal Colar | | #
Highlighted Colar | | #
Pressed Color . | #

Disabled Color I

Color Multiplier =i r———
Fade Duration 0.1
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Mavigation | Automatic

| Visualize |

On Click (Button)
List is Empty

+

Figura 26. Script asociado al objeto button

Compuesto de de los siguientes atributos:

- Interactable: Esta opcion sirve para definir si el botdn va a ser interactivo o no.

- Transition: Determina la manera en la que el control responde visualmente a las
acciones del usuario. Hay varias opciones de transicion dependiendo en qué
estado se encuentre el botdn. Los diferentes estados son: normal, highlighted,
pressed y disabled. Ofrece cuatro opciones:

O

O

None: Esta opcion sirve para que no se realice ninguna transicion, es
decir, que no se diferencie el estado del boton.

Color Tint: Cambia el color del botén dependiendo de en qué estado se
encuenrte. Es posible seleccionar el color para cada estado individual.
También es posible configurar la Fade Duration (Duracion de
desvanecimiento) entre diferentes estados. Cuanto mayor sea el nimero,
mas lento sera el desvanecimiento entre los colores.

Sprite Swap: Permite que diferentes sprites se muestren dependiendo
de en qué estado se encuentre el botén. Los sprites pueden ser
personalizados.

Animation: Permite crear animaciones dependiendo del estado del botén,
para utilizar esta opcion es necesario crear un componente animator.

- Navigation: Propiedades que determinan la secuencia de controles.

Para el ejemplo practico se ha elegido la transicion basada en una animacién ya que
servird como base para introducirlas. Las animaciones son muy interesantes ya que
permiten crear un recorrido predefinido dentro de la escena, es decir, si se quiere que
alguien pueda visualizar el resultado a través de las gafas de Realidad Virtual pero que
no tenga la capacidad de moverse libremente se puede crear un recorrido predefinido

por la escena.

Para crear una animacion, que sirva como transicion en los botones, se selecciona la
opcién Animation. Una vez seleccionada Unity proporciona la opcion de autogenerar
una animacion. Si se pincha en la opcién, el programa pide una ruta donde se guardara
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la animacion. Se recomienda crea una carpeta llamada Animations dentro de la carpeta
Assets. Una vez seleccionada la ruta es necesario darle alguna caracteristica a la
animacion. El primer paso consiste en abrir la ventana Animation en Window>Animation.
Una vez abierta y con el botén seleccionado en el arbol se puede seleccionar el estado
del boton para el que se quiera crear la animacién como se muestra en la siguiente
figura:

€ Animation
- M

Marmal Samples 60

~  Mormal
Highlighted
Pressed

Dizabled

Create New Clip...

Figura 27. Ventana Animation y fases de la transicion

Para el estado Normal no se creara una transicion, pero si para el estado Highlighted
gque se activara cuando el puntero se encuentre sobre el boton. Para crear la transicion
simplemente es necesario hacer clic sobre el botén record (el punto rojo de la izquierda)
y cambiar en el Inspector alguna propiedad del botén. Para el ejemplo se ha cambiado
el ancho y la altura para que cuando el puntero esté sobre el boton éste se haga mas
grande. Para la transicion Pressed se ha optado por hacerlo ain un poco mas grande.
De esta manera cuando el puntero se encuentre sobre el botdn éste se hara mas grande
y cuando se pulse serd un poco mas grande adn.

Una vez creada la transicion se cierra la ventana Animation y se puede comenzar a
definir qué accion realizard el botén al ser pulsado. El objeto botén que aporta Unity
tiene un solo evento llamado “On Click” que responde cuando el usuario completa un
clic.

Para el ejemplo se ha utilizado un panel con dos botones, uno de ellos transforma el
material de los tirantes del puente para que éstos sean verdes y otro devuelve el color
rojo inicial a los mismos.

PRUEBA A CAMBIAR EL COLOR DE LOS
TIRANTES™

VERDE ‘

__________J

“APUNTA HACIA EL COLOR QUE PREFIERAS
Y HAZ CLICK CON EL RATON

Figura 28. Tablero con botones creado para el ejemplo practico
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A partir de este ejemplo se sentara la base para la interaccion con los objetos de la
escena a través de la mirada.

Pare construir el panel con los botones se ha utilizado el lienzo creado en el apartado
4.5.4. Como ubicacién se ha escogido la entrada del puente por ser un lugar desde
donde se apreciara el cambio de color de los tirantes. Una vez colocado el lienzo se le
afiaden dos objetos tipo botdn a través de Create > |U > Button asegurandose de que
éste objeto es dependiente del lienzo. Es importante darle una escala adecuada tanto
al lienzo como a los botones. En caso de que se pierda la perspectiva se recomienza
ejecutar la escena, colocarse las gafas e ir ajustando el tamafio hasta quedar satisfecho.

Para el ejemplo préactico, como se puede ver en la figura de arriba, se ha afiadido al
lienzo dos botones, un titulo y un texto. Los objetos tipo botdn también tienen asociado
un texto que por defecto tiene la palabra Button escrita. En el ejemplo se han adaptado
los botones tanto en color como en texto para aclarar al usuario que ocurrira cuando
pulse los botones y se les ha afiadido una animacion para los diferentes estados.

45.8.2. Activando los botones con la mirada

Una vez creado los botones y las animaciones para los diferentes estados del mismo,
es necesario lograr que dichos botones se activen cuando se les mira. Una forma de
conseguir esto consiste en superponer sobre los botones dos objetos con un Collider
que seran interceptados por el rayo coincidente con el centro de la vision.

Como se ha escogido una forma rectangular para los botones del ejemplo, se afiadiran
dos objetos tipo cubo a los que se les quitara el mallado para dejarlos Unicamente con
la componente Collider.

Para que el rayo pueda distinguir estos objetos del resto en la escena, se creard una
nueva capa donde se colocaran Unicamente estos dos objetos. Para ello es necesario,
una vez seleccionado los cubos, ir a su Inspector y en la parte superior del mismo, donde
nos deja seleccionar el Tag, afiadir uno nuevo llamado Button seleccionando la opcién
“Add Tag...” como se muestra en la siguiente figura.

4 Navigation

Default

Untagged

Respawn

Finish
EditorOnly

MainCarera
Player Edit Collider
GameController

c Material)

Figura 29. Cémo afiadir una nueva capa para que el rayo de vision la distinga del resto
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Una vez afiadido simplemente es necesario ubicar ambos objetos en esa nueva capa
creada.

Figura 30. Botones con sus Objetos Collider asociados para detectar el rayo de vision

Una vez montado el panel con los botones animados y los Collider cubicos en la capa
Button es necesario generar un script que marque los botones cuando el centro de visién
se posa sobre ellos. Para el ejemplo practico se programado el siguiente codigo al que
se le ha llamado ButtonExecute:

using UnityEngine;
using UnityEngine.EventSystems;
using System.Collections;

public class ButtonExecute : MonoBehaviour

{

private GameObject currentButton;

void Update()

Transform camera = Camera.main.transform;

Ray ray = new Ray(camera.position, camera.rotation * VVector3.forward);
RaycastHit hit;

GameObject hitButton = null;

PointerEventData data = new PointerEventData(EventSystem.current);

if (Physics.Raycast(ray, out hit))

if (hit.transform.gameObject.tag == "Button")
{

hitButton = hit.transform.parent.gameObiject;
}

}
Pégina 50 de 62



MARINA OJANGUREN ALVAREZ

if (currentButton != hitButton)

{

if (currentButton != null)
{ //deseleccionar/unhighlight
ExecuteEvents.Execute<|PointerExitHandler>(currentButton, data,

ExecuteEvents.pointerExitHandler);

}

currentButton = hitButton;

if (currentButton != null)

{/Iseleccionar/highlight
ExecuteEvents.Execute<|PointerEnterHandler>(currentButton, data,

ExecuteEvents.pointerEnterHandler);

}

}

}

}

El funcionamiento del script es el siguiente:

Primero se declara privada la variable tipo objeto referente al boton.

Luego se crean unas variables para referirse a la camara, al rayo de vision
central, y al objeto sobre el que colisionard asi como la propia colisién. Tras lo
gue se define el rayo en funcién de la posicion de la camara y la colisién de éste
con un cualquier elemento.

Finalmente se define el comportamiento del botén en caso de que el rayo
colisione con un objeto ubicado en la capa Button. En cada frame (cada unidad
de tiempo) se capta el rayo que parte del centro de visién de la camara y se
comprueba si ha encontrado un objeto de la capa Button. En caso de que lo haga
se marca al padre del elemento (el boton en si) como seleccionado (highlight).

De la misma forma detecta si el rayo ha salido del objeto para deseleccionarlo
(unhighlight).

45.8.3. Seleccionando los botones al activar una tecla.

Se ha conseguido que se marque el botén cuando se enfoca hacia él. Para que el panel
formado por botones sea funcional deberia de activarse cuando se presiona una tecla
del ratén, teclado o mando. Para ello se creara una clase genérica llamada Clicker que
comprobard si el usuario ha presionado alguna tecla. Esto se puede lograr con el
siguiente codigo:

using UnityEngine;
using System.Collections;

public class Clicker

{

}

public bool clicked ()

{
}

return Input.anyKeyDown;
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Si, por el contrario, se quiere que se active Unicamente cuando se pulsa una tecla en
concreto, simplemente sera necesario especificar qué tecla en el script.

Una vez creada ésta clase, necesitamos afadir las siguientes lineas al script
ButtonExecute:

using UnityEngine;
using UnityEngine.EventSystems;
using System.Collections;

public class ButtonExecute : MonoBehaviour

{

private GameObject currentButton;
private Clicker clicker = new Clicker();

void Update()
{

Transform camera = Camera.main.transform;

Ray ray = new Ray(camera.position, camera.rotation * Vector3.forward);
RaycastHit hit;

GameObject hitButton = null;

PointerEventData data = new PointerEventData(EventSystem.current);

if (Physics.Raycast(ray, out hit))

{
if (hit.transform.gameObject.tag == "Button")
{
hitButton = hit.transform.parent.gameObiject;
}
}
if (currentButton != hitButton)
{

if (currentButton != null)
{ /lunhighlight
ExecuteEvents.Execute<IPointerExitHandler>(currentButton, data,
ExecuteEvents.pointerExitHandler);
}
currentButton = hitButton;
if (currentButton != null)
{//highlight
ExecuteEvents.Execute<IPointerEnterHandler>(currentButton, data,
ExecuteEvents.pointerEnterHandler);

}

if (currentButton != null)

if (clicker.clicked())
{

ExecuteEvents.Execute</PointerClickHandler>(currentButton, data,
ExecuteEvents.pointerClickHandler);
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}
}
}

Esto logra que si el boton estd seleccionado y el usuario presiona alguna tecla se
presiona el boton.

Por ultimo, es necesario definir qué pasara cuando el boton sea presionado. El objeto
Ul Button de Unity ofrece una gran cantidad de opciones en funcion del tipo de objeto
sobre el que se quiera actuar. Para el ejemplo se ha decidido cambiar el material de un
objeto para que el usuario pueda observar un cambio en el color de los tirantes.

Para afadirle esta opcion es necesario seleccionar el botén y acudir a su Inspector. En
él encontraremos una seccion llamada “On Click ()’ que permite anadir érdenes para
cuando se presione el botén. Acudiendo al boton “+” afiadimos el objeto sobre el que
queremos actuar, en este caso el grupo de objetos que forman los tirantes de puente.
Unity ofrece una lista de acciones que se pueden hacer sobre el mismo como se muestra
en la siguiente figura:

DESPLEGABLE QUE OFRECE QUE ACCIONMES
SE PUEDEN REALIZAR SOBRE EL OBIETO

Mo Funetion

GameObject bocl isstatic

Transform nt layer

MeshCollider string name
string tag
Brosdessthlessage (string)
Sendhiessage (string)
Sendhessagelpwards (siring)
Setdotive [baol)

ANADIR FUNCIONES PARA QUE SE ACTIVEN CUANDO
SE PRESIONA EL BOTON

Figura 31. Inspector de un objeto Ul Button y acciones permitidas por la clase On Click ()
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Entre ellas podemos elegir, por ejemplo, MeshCollider > Physicmaterial y escoger una
propiedad fisica a afiadir sobre el material del objeto cuando se presione el boton.

Para el propésito elegido (cambiar el color de los tirantes) una opcién sencilla es duplicar
el grupo de objetos formado por todos los tirantes y simplemente renombrarlo como
“tirantes verdes” y cambiarles el material. Una vez duplicado simplemente ordenaremos
a través de los botones que se active o se desactive un grupo.

Para el primer botdn, el verde, se activaran el grupo de tirantes verdes y se desactivara
el grupo de tirantes rojos. Par el segundo botén lo contrario.

Tras estas operaciones se dispone de un tablero con botones con los que se puede
interactuar a través de la mirada. Es momento para ejecutar la aplicacion y explorar el
funcionamiento del mismo y las sensaciones que despierta.

4.5.8.4. Afadir un puntero en el centro de la vision

Al ejecutar la escena se ha comprobado que resulta complicado saber cudl es el centro
de la vision para poder apuntar con exactitud hacia los botones.

Una solucién muy simple a este problema es afadir, como objeto dependiente de la
camara, un lienzo con una imagen centrada de tamafio muy pequefio y situar el lienzo
en la posicion (0,0,2) es decir en el centro de la vision alejado dos metros de los ojos
sobre el eje z. Esto permite disponer de un puntero en el centro de la vision que facilita
mucho la tarea de apuntar a los botones.

Otra manera sencilla de disponer de un puntero es afiadir a la cAmara un objeto Ul tipo
Cuad, que no es mas que un objeto bidimensional, y darle una escala muy reducida, del
orden de 0.01, para posteriormente posicionarlo, al igual que el lienzo, en la posicion
(0,0,2).

Como éste puntero es Util exclusivamente cuando se entra en contacto con el tablero
gue contiene los botones, se puede afiadir una Activador, al igual que para los carteles
interactivos, que active el puntero cuando nos acercamos a los botones. Para ello
afiadimos un objeto con un Collider, con la opcién “Is Trigger” activada, alrededor del
cartel con los botones, le afiadimos el script ActivarTexto y arrastramos el puntero a la
ventana que pregunta por el objeto que se quiere activar al entrar en contacto. Con ello
se habra conseguido que el puntero se active cuando se entra en contacto con el
Collider.

De la misma forma se puede afiadir otro script del mismo tipo al Activador para que
active el tablero con los botones, de manera que cuando nos acercamos al puente éste
se active junto con el puntero.

Con ello, habremos logrado crear un cartel con dos botones que se activan al mirarlos
y que se seleccionan al pulsar una tecla. Dicho cartel aparecera cuando el usuario se
acerque al puente junto con un puntero que facilite la tarea de apuntar a los botones.
Cuando el boton verde sea seleccionado los tirantes del puente cambiaran a ese color,
por el contrario, cuando el botdn rojo sea seleccionado estos volveran a su estado inicial.
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4.6. CREAR UN PASEO INTERACTVO POR LA ESCENA

Por dltimo, se creard un paseo predefinido por la escena. Esto permitira al usuario
controlar la vision del personaje, pero no el movimiento del mismo. Para ello es
necesario crear una animacién, del mismo modo que con los botones, pero esta vez
sobre el personaje principal.

El primer paso es seleccionar el personaje en el arbol del editor y acudir a la ventana
Animation. Debido a que sobre el personaje ain no se ha creado una animacioén, Unity
ofrecera crear una nueva a través del botén “Create”, que aparecera en el centro de la
ventana Animation. Una vez creada la animacion podemos elegir las propiedades del
objeto sobre las que se quiere crear una animacion, para el ejemplo queremos actuar
sobre la posicion del personaje luego seré la propiedad Transform > Position.

En la ventana Animation se crearan en eventos o “keys” sobre la linea de tiempo. La
linea de tiempo permite establecer la temporalidad de la animacion y se mide en frames
y en segundos. La linea vertical roja permite seleccionar el frame que se quiere
moadificar. Al lado de la linea de tiempo hay dos botones, el de grabar y el de reproducir.
Cuando el botén de grabar esta seleccionado los cambios hechos sobre el objeto
deseado en la escena seran agregados automaticamente a la animacién en el frame
seleccionado. El boton reproducir permite pre-visualizar la animacion. La propiedad
“samples” permite definir cuantos segundos equivalen a un frame de la animacion.
Reducir éste numero hace que la animacién sea mas lenta. Para no generar una
sensacion de malestar en el usuario reduciremos éste numero a seis.

Para crear la animacién sera necesario escoger el frame en el que queremos que
nuestro personaje alcance la nueva posicion y mover el personaje principal a dicha
posicién con el botén grabar seleccionado. Al realizar esta operacién se creard un
evento o “key” en la animacion que registrara la posicién a alcanzar en dicho frame.

GRABAR Y REPRODUCIR

SEGUNDOS POR FRAME LINEA TEMPORAL

PROPIEDAD QUE SE KEYS O ENEVENTOS

MODIFICA EN LA EN LA ANIMACION FRAME
ANIMACION SELECCIONADO

Figura 32. Ventana para crear una animacion en Unity

Para crear el recorrido crearan varios “keys” en los puntos por lo que pasara el personaje
principal. Es importante, una vez creado el recorrido, ejecutar la escena y comprobar la
velocidad con la que se mueve el personaje. Si ésta fuese excesiva sera necesario
separar las “keys” para que el personaje se mueva mas lento.

Una vez creada la animacion cuando se ejecute la aplicacion el personaje se movera
sin que el usuario realice ninguna accion. Cuando la animacion esté activa, el usuario
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tendra control sobre la vision, es decir, tendra la libertad de mirar para cualquier
direccion, pero no sobre el movimiento.

Esta opcién puede ser interesante a la hora de crear una visita virtual a una obra para,
por ejemplo, el cliente al que se le quiere vender la obra o para un alumno que quiera
entender el funcionamiento de una estructura. Ademas, al crear un paseo el disefiador
puede asegurarse de que el usuario encontrara todos los carteles y objetos interactivos
de la escena.

4.7. LA REALIDAD VIRTUAL Y LA CINETOSIS

La cinetosis es la sensacion de mareo provocada por el movimiento. La Realidad Virtual
puede llegar a producir éste efecto sobre el usuario por lo que es muy importante tenerlo
en cuenta a la hora de disefiar los modelos y las aplicaciones orientada al uso de esta
tecnologia.

Este fendmeno se debe a que, cuando una persona mueve la cabeza, su cerebro espera
gue el entorno cambie exactamente en sincronia, por lo que, si se genera algun retraso
perceptible, éste puede llegar a crear una sensacion de incomodidad en el usuario. La
latencia serd menor cuanto mejor sea la velocidad de renderizado por cada frame. Para
el uso de dispositivos de Realidad Virtual se recomienda una alta velocidad de frame
por segundo. En general, éste problema incumbe tanto a la calidad de los procesadores
como a la de los dispositivos de Realidad Virtual. En este campo ha habido grandes
avances y se espera alun mayores progresos en el futuro.

A mismo tiempo, los desarrolladores de aplicaciones que funcionen a través de
dispositivos de Realidad Virtual, tendran que tener en cuenta este problema de latencia
y otras causas de cinetosis, ya que no solo ésta sensacion se produce por culpa de la
tecnologia.

A la hora de desarrollar una aplicacién que mejore la experiencia del usuario y su
seguridad se debera de tener en cuenta que:

- La velocidad con la que se mueve el personaje por la escena debe de ser
moderada.

- Lasensacién de mareo disminuye si el usuario mira hacia adelante.

- La velocidad de giro de la cabeza debe de ser modera ya que el problema de
latencia aumenta cuanto mas rapido sea el cambio de posicién de la camara.

- Esnecesario afadir al entorno referencias visuales que ayuden al usuario a estar
orientado tales como horizontes u objetos cercanos.

- Por ultimo, es esencial prestar especial atencion al renderizado. Como se ha
visto durante el desarrollo del proyecto, algunos objetos, texturas o reflejos no
estan adaptados al uso de dispositivos de Realidad Virtual, por lo que es
fundamental eliminarlos si se quiere ofrecer una buena experiencia al usuario.

4.8. CONSTRUYENDO LA APLICACION

Una vez terminado el modelo, Unity permite crear una aplicacién para diferentes
plataformas a través de File >Building Settings. La ventana de Build Settings permite
escoger la plataforma de destino, ajustar los parametros para la construccion de la
misma y empezar el proceso de construccion.
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Una vez se haya escogido la plataforma objetivo y los ajustes, simplemente es necesario
afadir la escena o escenas que formaran parte de la aplicacion a través del boton “Add
Open Scenes” y seleccionar el boton “Build” para crear aplicacion.

4.8.1. Creando una aplicacién para PC

Una vez se haya creado el modelo con todas las caracteristicas deseadas, es hora de
generar la aplicacion.

Para ello, es necesario escoger la plataforma objetivo de la aplicacion. Para el ejemplo
se ha escogido PC por lo que se escogera en la lista “Platform” PC, Max & Linux tras lo
que aparecera en la pestafa “Target Platform” Window x 86_64.

Ademads, Unity ofrece las siguientes opciones:

- Development Build: que permite al desarrollador trabajar sobre la aplicacion
mientras ésta se construye.

- Autoconnect Profiler: cuando la opcién Development Build sea seleccionada,
permite al profiler estar conectado a la construccion.

- Script Debugging: si la opcién Development Build se selecciona, el codigo script
puede ser depurado.

Antes de generar la aplicacién sera necesario habilitar VR en Unity, si no se ha hecho
antes, para que la aplicacion admita el uso del dispositivo de Realidad Virtual que se
pretenda utilizar con la aplicacién. En el caso del presente proyecto el set Oculus Rift.

Build Settings [ = |

Scenes In Build

Settings for PC, Mac & Linux Standalone

Resolution and Presentation

Teon

Splash Image

OTRAS CONFIGURACIONES

Other Settings

PLATAFORMA OBIETIVO
DE LA APLICACION

Rendering
Rendering Path* [ Farward
Color Space® | Gamma
Auto Graphics AFI for Wirls
Auto Graphics API for Mady
Auto Graphics APT for Linsf
Static Batching It
Dynamic Batching =4
GPU Skinning* =]

ics Jabs (E imer[_|
Virtual Reality Supported
Wirtual Reality SDKs
= Oculus

Add Open Scenes =

é" PC, Mac & Linux Standalons
3

Target Flatform Windows i
Architecture *B6 | -
Copy PDB files
Development Build
Autaconnect Profiler
Script Debugging

REALIDAD VIRTUAL

Single-Pass Sterec Rende[ |

@ #box 360 Configuration
== s —_—
Xbox One | Scriphing Bn:kend ManeZi
b Learn about Unity Cloud Build Disable HW Statistics
_ Scripting Define Symbals
| Switch Platform | [ Player Settings... | [ Build || Buwild And Run_|

|CROSS_PLATFORM_INPUT

Optimization

Api Compatibility Level | NET 2.0 Subser ¥
i

Figura 33. Ventana Build Settings
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Para lograrlo es necesario abrir la ventana de Player Settings ubicada en File < Building
Settings y seleccionar el botdn Player Settings como se observa en la figura superior. Al
seleccionarlo, en la pestafia del Inspector se muestra una lista de caracteristicas entre
las que se encuentra una opcion de “Virtual Reality Supported”. Una vez activada, el
programa preguntara por el dispositivo de Realidad Virtual que serd utilizado.

4.8.2. Creando una aplicacion para web

La version mas reciente de Unity no permite generar un aplicaicon web que soporte el
uso de dispositivos de Realidad Virtual pero se puede montar una aplicacién destinada
a mostrar la escena a través de la pantalla del ordenador en un navegador Web.

Para ello es necesario escoger como plataforma de trabajo WebGL. Si se acude a las
Player Settings, Unity permite personalizar la pantalla de inicio de la aplicacion. Para el
presente proyecto se ha escogido como nombre de la compafiia “E.T.S. Caminos,
Canales y Puertos. Universidad de Cantabria” y como titulo de la aplicacion
“Virtualizacion del Puente de la Barqueta para Realidad Virtual’, ademas se ha anadido
como icono el logo de la Escuela.

La aplicacion WebGL est4 disponible en la pagina web: cuartas.es/tfm-moa
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5. CONCLUSIONES
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La Realidad Virtual ofrece, sin duda, una infinidad de ventajas a la hora de aproximarnos
a una estructura entre las que destacan:

- Ayuda al disefio y toma de decisiones en la fase de proyecto y construcciéon de
una obra.

- Venta del disefio al cliente o a los ciudadanos, que podrian tener un voto sobre
el proyecto.

- Herramienta didactica a la hora de entender el funcionamiento de cualquier
estructura compleja. Puede ofrecerse una vision global de la estructura y su
funcionamiento. En el ejemplo practico llevado a cabo en el proyecto, se ha
representado tanto la estructura real como un esquema tridimensional del
funcionamiento del puente. Incluso puede ofrecer una visién practica de como
construir una estructura.

- Herramienta turistica o histoérico-didactica para ofrecer un recorrido interactivo
por las grandes infraestructuras del mundo.

El objetivo principal del proyecto consiste en explorar las alternativas para virtualizar una
obra e interactuar con ella en tres dimensiones, analizando el alcance y posibilidades
que puede ofrecer dicho proceso para los Ingenieros Civiles.

La conclusion méas destacada es que el motor de renderizado en tiempo real
multiplataforma Unity 3D, es una herramienta muy Uutil para importar modelos
tridimensionales a un entorno virtual y para interactuar con dicho entorno a través de la
Realidad Virtual.

Durante el desarrollo del proyecto, se ha podido comprobar que el proceso para importar
un modelo tridimensional a un entorno que nos permita visualizar dicho modelo a través
de la Realidad Virtual es relativamente sencillo. A su vez, se ha investigado la forma en
la que incorporar un controlador que pueda moverse por la escena sin crear una
sensacion de malestar al usuario. Por otro lado, se han desarrollado mecanismos para
interactuar con el modelo, lo que ha resultado ser un proceso mas complejo que
requiere, ademas, de conocimientos en programacion.

El presente proyecto sirve, por tanto, como base para cualquier persona que quiera
introducirse en la Realidad Virtual, ofreciendo un guia para crear aplicaciones que
incluyan terreno y estructuras reales y diversas formas de interactuar con los objetos
que forman parte del entorno virtual creado.

Por dltimo, cabe destacar que las empresas que se dedican a la fabricacién de
dispositivos de Realidad Virtual, como Oculus Rift, prevén un aumento significativo en
el nimero de clientes no asociados a los videojuegos, es decir, otros sectores estan
mostrando interés por esta tecnologia. Dentro del campo de la Ingenieria, no seria
extrafio esperar que los grandes desarrolladores de software de modelado 3D, como
Autodesk o Solidworks, desarrollen en un futuro aplicaciones que permitan el manejo de
sus modelos en tres dimensiones, evitando asi el proceso necesario para importar sus
modelos a otras plataformas con el objetivo de interactuar con ellos en tres dimensiones.
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